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1.1 About the Manual

This manual is intended for all users who want to learn how to use Nero Burning ROM. It is
process-based and explains how to achieve a specific objective on a step-by-step basis.

To make best use of this documentation, please note the following conventions:

!

1. Start ...

OK

(see...)

[.]

Indicates warnings, preconditions or instructions that have to be
precisely followed.

Indicates additional information or advice.

The number at the beginning of a line indicates a prompt for action.
Carry out these actions in the order specified.

Indicates an intermediate result.

Indicates a result.

Indicates text passages or buttons that appear in the program
interface. They are shown in boldface.

Indicates references to other chapters. They are executed as links and
are shown in red and underlined.

Indicates keyboard shortcuts for entering commands.

1.2 About Nero Burning ROM

The powerful burning software Nero Burning ROM allows you to burn your data, music and
videos to disc. Nero Burning ROM gives you full, customized control of your burning projects.
You can — among other things — define the file system, the length of the file name and the
character set; you can also change the disc label. And of course, you can also customize the
Nero Burning ROM toolbar and change the keyboard shortcuts.

Despite its wide range of features, Nero Burning ROM has remained an easy-to-use burning
program that creates discs in just a few steps. You select the disc type to be burned
(CD/DVD/BIlu-ray), define the project type, add the required data and then start burning.

Using Nero Burning ROM you can save audio files from an Audio CD to the hard drive. In the
process, the files are encoded, i.e. converted into a format that the computer can read. The
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Audio CD can be automatically identified with Gracenote. So called metadata such as title,
genre, and track title are accessed by the Gracenote Media Database and associated to the
tracks. That way you have audio files that are accurately and fully named after the encoding
process.

Music recognition technology and related data are provided by Gracenote®.
Gracenote is the industry standard in music recognition technology and related
content delivery. For more information, please visit www.gracenote.com.

1.3 Versions of Nero Burning ROM

Nero Burning ROM is available as part of Nero 12, Nero 12 Platinum and as a standalone
product (Nero Burning ROM 12).

All versions offer the full range of functions, but Nero Burning ROM as standalone product
does not offer access to Nero MediaBrowser unless Nero Kwik Media is installed.

You can always upgrade your standalone version to Nero 12 or Nero 12 Platinum at
WWW.nero.com.

-+ Nero CoverDesigner is not installed automatically with Nero 12. However, it can
‘@ be downloaded for free from the Download section at www.nero.com or via Nero
N ControlCenter and used together with Nero 12. Please see the separate Nero
CoverDesigner user manual for full instructions.

Nero WaveEditor is not installed automatically with Nero 12. However, it can be
downloaded for free from the Download section at www.nero.com or via Nero
ControlCenter and used together with Nero 12. Please see the separate Nero
WaveEditor user manual for full instructions.

<

1.4 Working With the Program

The main function of Nero Burning ROM is to select files and folders and to burn them to a
disc. This is done in three basic steps:

m In the New Compilation window, select a disc type and the disc format and set the
options on the tabs.

m In the selection screen, select files that you want to burn.
m Start the burn process.

See also

£ Main Screen —12
g Compiling Data Disc —22
g Compiling Audio CDs —44
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2 Mixed Mode CD and CD EXTRA —54
g Compiling DVD-Video —72

1.5 Starting the Program

There are several ways to open Nero Burning ROM, depending on various factors such as
the product you have installed and the operating system you are using.

On Windows 7 and earlier versions of Windows, you can start Nero Burning ROM via:
m Start (the start icon) > (All) Programs > Nero > Nero 12 > Nero Burning ROM

m the I(j:\

Nero Burning ROM 12 desktop icon

./-:-.\-.
m the L-@-' Nero 12 Welcome Application if you use Nero 12

~'+. The Welcome Application offers information about the main use cases and links
C ? to tutorials and other interesting Internet sites by Nero.

./ WY
To start the Welcome Application, click the E@;’ Nero 12 icon on your desktop

(Windows 7 and earlier) or select the Nero 12 tile on the application selection
screen (Windows 8).

On Windows 8, you can start Nero Burning ROM via:

m the Nero 12 tile (Windows 8 style user interface) or the Nero 12 desktop icon (desktop
user interface) if you use Nero 12

=
ul K
al e
e

m the Nero Burning ROM tile (Windows 8 style user interface) or the Nero Burning

ROM 12 desktop icon (desktop user interface) if you use Nero Burning ROM 12 as a
standalone product

~ ltis also possible to start tasks with Nero Burning ROM from the context menu of
’ ? a file or folder.

At first startup and if not disabled, the Welcome to Nero Burning ROM window is
displayed. Here you will find information about the main use cases with Nero
Burning ROM and links to tutorials and other interesting Internet sites by Nero.
The window can be started at any time within Nero Burning ROM by clicking the
Get Started button.

<
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1.6 System Requirements

Nero Burning ROM is part of the Nero product you have installed. Its system requirements
are the same. Detailed system requirements of this and all other Nero products can be found
in the Support section on our Web site www.nero.com.

1.7 Supported Formats and Codecs

1.7.1 Disc Types

<

CD
DvD

Blu-ray - burning only

You can find more information on Blu-ray support at

? www.nero.com/link.php?topic _id=416.

The actual disc formats that are available and the actual disc types (e.g. DVD) to
which can be written depend on the selected recorder.

1.7.2 Disc Formats

Data CD (ISO, UDF, ISO/UDF)
Data DVD (ISO, UDF, ISO/UDF)
Blu-ray data disc (ISO)
SecurDisc CD/DVD/Blu-ray Disc
Audio CD

Mixed Mode CD

CD EXTRA

DVD-Video

Nero Image (NRG)

CUE-Image [Import only]
ISO-Image

AVCHD video

BDMV-Video

Nero DiscSpan (UDF)
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1.7.3 Audio Formats and Codecs

AAC elementary stream (AAC) - not ripping

Audio Interchange File Format (AIFF, AlF)

Compact Disc Digital Audio (CDA) - not encoding
Dolby Digital (AC3) - only source format in compilations
MP3 / mp3PRO (MP3)

Nero AAC (MP4, M4A)

Ogg Vorbis (OGG, OGM)

PCM WAV file, ADPCM Wav file (WAV, WAVE)
Windows Media Audio (WMA) - not ripping

Free Lossless Audio Codec (FLAC)

1.7.4 Video Formats and Codecs

Advanced Streaming Format (ASF)

Audio Video Interleave (AVI)

Digital Video (DV)

Moving Picture Experts Group-2 (MPG, MPEG, DAT, M2T)
Nero AAC Codec (MP4)

QuickTime Movie (MOV)

Video Object (VOB)

1.7.5 Image Formats

Bitmap (BMP)

Device Independent Bitmaps (DIB)
Graphics Interchange Format (GIF)
Icon Image File (ICO)

JPEG File Interchange Format (JFIF)
Joint Photographic Expert Group (JPEG, JPG, JPE)
Picture Exchange (PCX)

Portable Network Graphics (PNG)
Portable Pixel Map (PPM)

Targa Image File (TGA)

Tagged Image File Format (TIFF, TIF)
Windows Media File (WMF)

Nero Burning ROM 10
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1.7.6 Formats for Playlists

m Moving Picture Experts Group Audio Layer 3 Uniform Resource Locator/MP3 URL (M3U)

® Moving Picture Experts Group Audio Layer 3 Uniform Resource Locator/MP3 URL +
UTF-8 (M3U8)

m Playlists File Format (PLS)

lm Nero Burning ROM 11



User Interface

2 User Interface

2.1 Main Screen

The main screen of Nero Burning ROM is the starting point for all actions. It consists of a
menu bar and a toolbar with buttons and a drop-down menu.

15 Wern Buming RN

il

)

Fle Eil Vies Recorde Sdvas  Wiedew Help

& O HL-DT-5T DVDRAN GHXHELS LN ]

HL-DT-5T DA GHODMELS

Main window with menu and toolbar

The following menus are available:

File

Provides program facilities such as opening, saving, and closing. You can
also open the setting options for the compilation, update the compilation, and
define configuration options.

Edit

Provides editing facilities for the files in the selection screen such as cutting,
copying, and deleting. You can also display the properties of a selected file.

View

Provides the option to customize the user interface and to refresh the file
browser.

Recorder

Provides recorder facilities. You can select the recorder here, start the burn
process, and erase a rewritable disc. You can also eject a disc and display
disc information.

Extras

Provides the option to convert tracks into other formats and to save the songs
on an Audio CD to the hard drive.

Window

Provides the option to alter the position of the compilation area and browser
area.

Help

Provides help facilities such as opening the help, and shows information
about the application.

Nero Burning ROM 12
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The following configuration options are available in the tool bar of the main screen.

1l &

Opens the New Compilation window where you choose a compilation type
and where you can set options for that compilation type as well as burning
and copying.

Opens an existing compilation.

Saves the active compilation.

Cuts selected elements in the compilation (selection).
Copies selected elements of the compilation (selection).

Pastes a selection that was cut or copied beforehand.

Starts Nero MediaBrowser, which you can use to easily find, view and access
media files and add them to your project.

Not available for video compilations (DVD-Video for example) as video
structures are not supported by Nero MediaBrowser.

Starts Nero CoverDesigner, which you can use to create labels and covers.
Information about a current compilation such as title, number, and names of
the files is incorporated into the document data. You will find further
information in the Nero CoverDesigner manual.

Only available if Nero CoverDesigner is installed.

Starts Nero Express. Nero Express is a wizard-driven application based on
Nero Burning ROM. You will find further information in the Nero Express
manual.

Starts the burn process by opening the Burn Compilation window containing
the Burn tab.

Starts the copy process by opening the New Compilation window containing
the Burn tab.

Displays information on the disc inserted, such as contents (if any) and
capacity for instance.

Opens the selected drive.

Shows or hides the file browser.

Nero Burning ROM
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Recorder
selection Displays available recorders.
menu
Opens the Choose recorder window where you select an available recorder
= for the burn process from a list.
Opens the Burn Label window where you can create or load a label to print
4 on the label or data side of a Labelflash DVD.
[ ¥ |

This button is only available if a recorder that supports Labelflash is
connected.

Launches Nero CoverDesigner to create or load a label to be printed on the
label side of a LightScribe disc.

This button is only available if Nero CoverDesigner is installed and if a
recorder that supports LightScribe is connected.

o Displays information on the program and version number.
Opens the Welcome to Nero Burning ROM window where you will find

Get Started information about the main use cases and links to tutorials, the online help,
the Nero community and other interesting Internet sites by Nero.

.] Access to Nero MediaBrowser and Nero Express is only provided by Nero
Burning ROM as part of Nero 12.

e

-+, With Nero CoverDesigner, you can create covers and labels for discs (CDs,
" ? DVDs, etc.).
Nero CoverDesigner is not installed automatically with Nero 12. However, it can
be downloaded for free from the Download section at www.nero.com or via Nero
ControlCenter and installed together with Nero 12. You will find further information
in the Nero CoverDesigner manual.

See also
New Compilation Window —15
2 Bootable Disc —79
£ LightScribe —85
£ Labelflash —89
= Loading Image File —82
= Erase Rewritable Disc Window —113
£ Configuration Options —122
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2.2 New Compilation Window
In the New Compilation window you can select the disc type and configure the options for
the disc format. The window basically looks the same for all disc types. The only difference is
the tabs that are available. When you start Nero Burning ROM, the New Compilation
window opens automatically. If the window is not open, click the New button. The window
consists of a drop-down menu, a selection list, various tabs, and buttons.

Mew Compilation
4 VD »| [Info | Mutsession |neroDiscSpen | Autorun |UDF | Label | Dates [Misc | Bum

Multisession

a @ Start Mulbsession disc

Conpnue Multisession dsc
Mo Mytisession {(Mero DiscSpan is possible)

Options

=

DVD Copy

8-

DVD-Video

AVCHD({TM] video

oo [y | E

New Compilation window, CD-ROM disc type

If the Image Recorder is not enabled, only those disc types supported by the physical
recorder are displayed in the drop-down menu. If the recorder can only burn CDs, the drop-

down menu is grayed out.

-+ Using Nero Burning ROM you can create image files for disc types that the

- ? installed recorder cannot burn. You can enable this function via the File >
Options > Expert Features menu, Enable all Nero supported disc types for
the Image Recorder check box. The drop-down menu in the Compilation
window then makes available all supported disc types.

The following entries are available in the selection list:

Creates a data disc; all file types can be burned. The burned

Ecn:tlzDVD ROMEI data complies with the UDF standard.
i u-ray Additionally you can use the Nero DiscSpan feature to
(UDF) ilati i i
comfortably burn a compilation on multiple discs.

lm Nero Burning ROM 15
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Entry
Audio CD

Entry
Mixed Mode CD

Entry
CD EXTRA

Entry
CD/DVD/Blu-ray Disc
Copy

Entry
CD/DVD-ROM (Boot)

Entry

CD/DVD-ROM/Blu-ray
(1SO)

Entry

CD/DVD-ROM
(UDF/ISO)

Entry

CD/DVD-ROM/Blu-ray
(SecurDisc)

Entry
DVD-Video

Entry
AVCHD (TM) video

Creates a standard Audio CD that can be played on all (audio)
CD players at least.

Creates a CD with data and audio files in a single session.
Usually a data file is followed by one or more audio files for
instance (e.g. soundtrack for PC games).

Older Audio CD players are often not capable of recognizing the
data file and attempt to play it.

Creates a multisession CD with audio and data files that are

stored in two sessions. The first session contains the audio files
and the second session the data.

Common CD players play the first session as Audio CDs. The
second session can only be used by PCs with a CD-ROM drive,
it cannot be recognized by a normal CD player.

Copies a source disc to a CD/DVD/Blu-ray Disc.

Creates a bootable disc.

Creates a data disc, each file type can be burned. The burned
data complies with the ISO 9660 standard.

Creates a data disc; all file types can be burned. The burned
data complies with the ISO and UDF standards.

Creates a SecurDisc disc, that includes data integrity and
reconstruction. Additional SecurDisc features include the
possibility to protect the data on your disc against unauthorized
access with a password, to digitally sign the disc, and to
configure the data redundancy.

Creates a DVD that delivers high-quality playback of video
and/or picture files on DVD players.

You can use Nero Burning ROM to burn a DVD if the DVD video
title, i.e. a complete DVD folder structure including premastered
files is already available.

Creates an AVCHD video disc that delivers high-quality playback
of camcorder video and/or picture files on DVD or Blu-ray
players.

Nero Burning ROM 16
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You can use Nero Burning ROM to burn an AVCHD video disc if
a complete AVCHD folder structure including premastered files
is already available.

Creates a Blu-ray Movie (BDMV) disc that delivers high-quality

Entry playback of video files on Blu-ray players.

BDMV-Video You can use Nero Burning ROM to burn a BDMV-Video disc if a

complete BDMYV folder structure including premastered files is
already available.

l In Nero Burning ROM it is not possible to convert video files to DVD-Video, an

AVCHD video, or a BDMV-Video. Converting video files to DVD-Video, to AVCHD
video, or BDMV-Video is possible in Nero Video for example. Nero Video is
included in the full version of Nero 12. More information about Nero Video is
available on the Web site www.nero.com, and more information about video
editing is available in the separate Nero Video manual.

The actual disc formats that are available and the actual disc types (e.g. DVD) to
which can be written depend on the selected recorder.

<

A Jump List is provided by Nero Burning ROM under the Windows 7 operating
system. Compilation types, e.g. Audio-CD, can be chosen directly from the Jump
List.

<

The following buttons are available:

Starts Nero Express. Nero Express is a wizard-driven application
based on Nero Burning ROM.

Only available in Nero Burning ROM as part of Nero 12.

Button
Nero Express

Button Opens a file browser where you can find and open a saved
Open compilation. You can also open an image file in order to burn a disc.
Button Creates the selected compilation and displays the selection screen
New where you can select the files for burning.
Button

Closes the New Compilation window.
Cancel

You can set the options for the respective disc format on the tabs in the New Compilation
window.

'm Nero Burning ROM 17
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’ > Which tabs are available depends on the disc type that is selected.
¥

The following tabs are available:

Tab
Info

Tab
Multisession

Tab
Nero DiscSpan

Tab
Autorun
Tab
ISO
Tab
UDF
Tab
Label
Tab
Dates
Tab
Misc
Tab
Audio CD
Tab
CDA Options

Shows statistical information on the compilation.

Contains options for starting and continuing multisession discs.

Contains the option for activating the Nero DiscSpan feature. This
allows you to comfortably burn a compilation on multiple discs when
the data to be burned is too large to fit on a single disc.

Contains the option to select a file to be executed automatically
when the disc is inserted into the disc drive.

Contains options for configuring the ISO file system.

Contains options for configuring the UDF file system.

Defines the labels of the disc.

Allows you to define the dates of the compilation and of the
associated files. You can also specify a validity period for the disc.

You can access the data regardless of the validity period specified.

Defines whether and which files are stored in the buffer memory. If
you posses a Lightscribe recorder you can create the label here or
select what is to be printed. For the CD-ROM (I1SO) disc type, you
can convert the code for an AVI video here to make it compatible
with Xvid/MPEG -4 or DivX.

We recommend that you only convert the code if you have

experience with FourCC codes and AVI videos.

Contains options for configuring audio files.
You can also enter additional information about the CD.

Defines the strategy used by Nero Burning ROM for handling CD-DA
files from a source audio CD.
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Tab
Contains options for configuring albums.
CD EXTRA
Tab . . S .
Boot Contains options for configuring a bootable disc.
Tab . . N .
Contains options for configuring burning.
Burn
See also

Compiling Data Disc —22

g Compiling Audio CDs —44

E Mixed Mode CD and CD EXTRA —54
& Compiling DVD-Video —72

2.3 Selection Screen

The selection screen is displayed in the main screen after you select the disc type and
format in the New Compilation window and click the New button. The selection screen
consists mainly of the compilation area and the browser area. Essentially, all selection
screens have the same structure.
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Selection Screen

The compilation area (Disc Content) is located on the left side of the screen, and is named
after the relevant compilation. Files and folders are compiled here for burning. In the browser
area (File Browser) on the right side you can find the elements that you want to burn. You

Nero Burning ROM
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can add data to your projects using the drag and drop function: Drag and drop the elements
from the File Browser area to the Disc Content area.

’ - Ifthe File Browser area is hidden, you can show it again using the ., button.
F

The following setting options are available:

Allows you to select another disc type without loss of
information. The option to change the disc type is useful when

Disc type drop-down starting a compilation without knowing how much space is

menu required by the files.
Available for data compilations only.
Allows you to expand or shrink the capacity bar according to
Selection list the type of DVD you are going to burn. Choose the DVD9 (8.5
DVD9 (8.5 GB) / GB) option for a double layer DVD (DVD DL) and DVD5 (4.7
DVD5 (4.7 GB) GB) for a single layer DVD.

Available for all DVD compilations.

Allows you to expand or shrink the capacity bar according to
the type of Blu-ray Disc you are going to burn:

BD QL (BDXL) (128 GB) for a quadruple layer Blu-ray Disc,
BD TL (BDXL) (100 GB) for a triple layer Blu-ray Disc,

BD DL (50 GB) for a double layer Blu-ray Disc (BD DL) and
BD (25 GB) for a single layer Blu-ray Disc.

Selection list

BD QL (BDXL) (128 GB) /
BD TL (BDXL) (100 GB)
BD DL (50 GB) /

BD (25 GB) . . L
Available for all Blu-ray Disc compilations except BDMV-
Video.
Button Starts the burn process immediately. If you want to check or
select the burn or compilation options again before burning,
Burn Now

click the Burn button in the upper part of the screen.

The bottom margin of the screen contains a capacity scale in MB or GB for data discs or
minutes (min) for Audio CDs. The exact size of the scale will depend on which disc type you
have selected.

Actual capacity of media formats

? The actual capacity of the DVD5, DVD9, BD DL, and BDXL media formats is less
than as stated by the disc manufacturers. For example, the actual capacity of a
4.7 GB DVD?5 is around 4.38 GB only.

This is because of different conversion systems. A DVD5-media format can
handle 4.700.000.000 bytes, but this number is not equal to the 4.7 GB stated by
the disc manufacturers. The correct conversion factor for bytes is not 1000, but
1024:
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1024 byte = 1 KB

1024 KB * 1024 KB =1 MB

1024 KB * 1024 KB * 1024 KB = 1 GB

A DVD can handle 4.700.000.000 bytes:

4.700.000.000 bytes = 4.589.843 KB = 4.482 MB = 4.377 GB

The capacity bar in Nero Burning ROM will always show you the correct amount
of bytes measured in MB or GB.

When you are compiling files, a capacity bar shows you the estimated size of the selected
files and the available space on the disc. The color of the capacity bar indicates whether the
data will fit on the disc or not:

Green capacity bar  The data will fit on the disc.

The data might fit on the disc. The size of the disc that has been

Yellow capacity bar . . . o
P y inserted will determine whether the data will fit or not.

The data will not fit on the disc.

Red capacity bar . , )
(Unless you have inserted an oversize disc.)

The yellow and red marks are set by default for discs that are commercially available. The
disc type you have selected will determine the exact scale value.

-+ Capacity of the CD recordable disc

’ ? For example, blank CDs are available with a capacity of 650 MB (74 min) or 700
MB (80 min). Therefore, the yellow mark is set for CDs at 650 MB and the red at
700 MB.

Display the Capacity Bar

If the capacity scale is hidden you can display it again by clicking the File >
Options > Compilation menu and by selecting the check box Show the
compilation size in the Nero status bar.

<
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3 Data Disc

3.1 Compiling Data Disc

With Nero Burning ROM you can compile and burn all types of files and folders. If a Blu-ray
recorder is installed on your computer you can burn data CDs, data DVDs and data Blu-ray

Discs. If you have a CD recorder you can only burn data CDs. The procedure for all data
compilation methods is identical.

-1+ The Image Recorder is also suitable for creating an image of a disc type not
" ;’ supported by the connected recorder. For example, you can therefore create a

DVD image without having installed a DVD recorder. You can then write the
image to a disc at any time.

To create a data disc, proceed as follows:

1. Select the desired disc format (CD, DVD, Blu-ray) from the drop-down menu in the New

Compilation window. (In the case that the New Compilation window is not opened, it can
be opened by clicking the New button on the main screen.)

= The selection list shows the compilation types that can be burned.

Mew Compilation [
[ ovee »| [Info | Muitsession | Neso DiscSpan | Autorun |UDF | Lebel | Dates |Msc | Bum
- Multizession
ﬁ @ Start Mulbsession disc
» Conprue Multisession disc
Mo Myltisession {Mero DiscSpan is possible)
= Options
o=t Refresh compilation when importing sessior
DVD Copy i
DVD-Video
AVCHD{TM] videa
ﬁ Mero Express | o Gpen.., | l [iew ‘ ‘0 Cenced

New Compilation Window
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You can select an appropriate disc format without loss of information at any time
in the main screen. Note that this has to be technically possible - for example you
are obliged to burn an Audio CD to a CD. But it is possible to start with a data CD
and change later to a data DVD, for example. The possibility to change the disc
type is useful when starting a compilation without knowing how much space is
required by the files.

2. Select the desired compilation type for a data disc from the selection list (CD/DVD-ROM/
Blu-ray Disc (UDF) , CD/DVD-ROM/Blu-ray Disc (ISO), or CD/DVD-ROM/Blu-ray Disc
(UDF/1SO).

= The tabs with the configuration options that are valid for this compilation type are
displayed.

3. Set the options you require on the tabs.

Enabling Nero DiscSpan is useful, if the file size of the data to be burned is
larger than the disc size or if you do not know exactly whether the files fit on one
disc. With Nero DiscSpan the files are burned to several discs if necessary. Nero
DiscSpan is only available for UDF-compilations.

Enabling Multisession is useful, if the file size of the data to be burned is much
smaller than the disc size or if you are not sure, if your compilation is complete
yet. With Multisession, you can burn additional content later on.

Note, that you can either enable Nero DiscSpan or enable Multisession.

4. Click the New button.

= The New Compilation window is closed and the selection screen is displayed.

b T - Nerg Barmang ROR _TE
Ble Edt View Bocoede B Mindow  Hep x
5 - - T s - cs
Mew | n = m r,j" W B e o com &) B £ D HLOT-STOVORAM GHANSSS = fot | n i
[hsc Cantani Fike Brommer b
B e - & - @ - WD
o Kew ; Mamie Site Type by, Felduii| b=
e o ETEKE DEGimage | — =
B Flere 2 jpg STKE PEGimage || o Ml Desivop Hame Sire e
B ero CovenDerigres 13S3KE PG image  Librariey

-~ Litrarmm

A 4dmnidrrin:
B Compester
"*Hﬂn ik

s Dt [E1 B Controd Pans
oA EO-RE Driv [F] 5 Recycle Bin
g Netweark ) Hero Backdlip 11 IKE
§ Control Banel #3 Hero Burming ROM 11 JER e
Recypeie Bin B Flarn Kk Misdia 1KE G
i P 11 = Kero Yikon 11 TKB %
Hars: Boming RO8 L]
My CoverDesgner Fal
il _
] L]
‘ 109 MIE 20 MB 0 M M :r:olua 100 B 700 ME 300 MB i
Totul sitm on dive: 3 W8 HL-DT-5T DVDRAR GHANELS
Compilation screen
lm Nero Burning ROM 23



Data Disc

5. Select the files/folders that you want to burn from the File Browser area.

6. Drag the required files/folders into the Disc Content area on the left side.

= The files are added to the compilation and displayed in the compilation screen. The
capacity bar indicates how much space is required on the disc.

-+, InNero Burning ROM, there is the option of defining filters for individual files or
‘@ folders by dragging files or folders into the compilation areas with the depressed
N right mouse button. For instance, it is possible to filter for a particular type of file
(*.doc, *.xlIs, *.txt) or select which type of file is not to be taken up in the
compilation area.

It is very easy to hide files in data compilations for additional protection or for
security reasons so that they do not appear on the normal display. The files
behave in the same way as other hidden system files that are hidden by default,
but can easily be displayed. To hide files, right-click the required file, select the
Properties option and then select the Hide check box.

<

Nero Burning ROM supports virtual search folders in the Windows Vista operating
system. The search is selected by dragging the search folder into the compilation
area. If you want to select the files of the search folder, you must open the search
folder and drag the files into the compilation.

2

7/ . Repeat the previous step for all files that you want to add.
= You have successfully compiled a data disc and can now burn this compilation.

See also
Selection Screen —19

3.1.1 Defining Options

3.1.1.1 Multisession Settings
The Multisession tab provides the option to create multisession discs for data discs.
Multisession discs can be burned in multiple sessions until you have reached the maximum
disc capacity. A session is a self-contained data area that is burned using a single process,
and consists of a lead-in (with the table of contents), one or more tracks, and a lead-out.
Discs without the multisession option, e.g. Audio CDs, are burned in a single session.

If a new multisession disc is being started, Nero Burning ROM also saves (if possible) the
point of origin for the files. This information is used when continuing the multisession disc.

If a multisession disc is being continued, Nero Burning ROM automatically sets a cross
reference to the imported session, i.e. the table of contents for the imported session is
copied to the table of contents for the current session. You must define which session is
being imported when starting your compilation. The files in the previous sessions are
retained and continue to take up space. Nero Burning ROM automatically verifies whether
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the correct multisession disc has been inserted for continuation. If not, the disc is ejected.

You can add new files to the compilation or delete files from the compilation when you
continue the multisession disc. Files and folders from the session to be continued can even
be refreshed, that means, changes in the folders like updated or deleted files can be taken
over to the compilation. In any case, after the burn process the disc gives you access to
exactly these files and folders that were visible in the compilation in Nero Burning ROM.

.+ Ifyou disable the Finalize disc check box on the Burn tab, you can always burn
" ? additional sessions on the disc, but then only the last session will be visible and
you will only be able to access data from the last session.

Multisession disc

) ? Multisession discs are particularly suitable for backing up important files burned
on a regular basis.

Mew Compilation [
4 DVD: = | [info | Muitisession | Neso DiscSpan | Autorun | UDF | Lebel | Dates | Misc | Bum
.|| Multisession
@ Start Mulbsession disc
Conpnue Multisession disc
o Myltisession {Mero DiscSpan is possible)
Options
e asf P
VD Copy '
set
i
DVD-Video
AVCHD{TM] videa
= g L
Howeom (o] [ @ o

Multisession Tab

The following option buttons are available on the Multisession tab in the Multisession area:

Start Multisession disc

Burns the selected compilation in one session to the disc.

If the disc already contains sessions, you can also select this
option. Sessions are then not imported and cross references are
not set. This means that only the last session will be visible and
you will only be able to access data from the last session.
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Continue Multisession
disc

No Multisession

Continues a multisession disc by burning an additional session
to a disc with at least one session. Cross references to the
imported session are set in the process.

When you select this option, the multisession disc must be
inserted in a drive. You then have to define which session is
being continued. The compilation screen will show the visible
files and folders on the multisession disc, but grayed out.
Everything you see in the compilation screen will be accessible
on the disc later on.

Creates a disc without a multisession.

However, even a disc without a multisession can be continued
as long as it is not finalized. Sessions are then not imported and
cross references are not set. This means that only the last
session will be visible and you will only be able to access data
from the last session.

When selecting the Continue Multisession disc option button, the Options area is
available with the following check boxes:

Refresh compilation
when importing
session

Replace files in
compilation

Remove deleted files
from compilation

Add new files to
compilation

Gives you the possibility to refresh your compilation (and
therefore the accessible files on the multisession disc after
burning).

On the multisession disc, Nero Burning ROM has saved (if it has
been possible) the point of origin for the files. If the files can be
accessed on your computer, Nero Burning ROM can refresh the
compilation to match the files at the point of origin.

If there is a file in the imported session that has been updated
on its point of origin in the meantime, then the outdated version
in the compilation will be replaced with the newest version.

If there is a file in the imported session that has been deleted on
its point of origin in the meantime, then the file in the compilation
will be deleted, too.

If there is a folder in the imported session, and on its point of
origin a file has been added to this folder, then this file will be
added to the compilation, too.
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3.1.1.2 Autorun

On the Autorun tab in the New Compilation / Compilation Properties window you can
choose a file to be executed automatically when the disc is inserted into a disc drive (on
Windows systems). Furthermore you can select an icon to represent the disc in the Windows
Explorer. The icon has to be in the *.ico format, but will be converted by Nero Burning ROM
12 if you choose another format.

File and icon are selected from the Disc Content area, that means, from the files you have
already added to the actual Nero Burning ROM 12 compilation. So first, you have to compile
your files and then open the Compilation properties window by clicking File > Compilation
Properties. (The window is also opened when you click the Burn button in the task bar.)
Then you can choose file and icon for the autorun execution.

3.1.1.3 UDF Settings

The UDF tab provides options for configuring the UDF (Universal Disc Format) file system.
The UDF standard was developed by Osta (Optical Storage Technology Association) in
response to the requirements of DVDs. The standard works on all platforms.

The following setting options are available in the Options drop-down menu:

Entry Sets options automatically for the UDF file system.
Automatic Settings  We recommend that you select this entry.

Entry Enables you to manually define the UDF partition type and the
Manual Settings file system version.
Entry Creates a disc that is compatible with an Xbox.
Enable Xbox This entry is available if the No Multisession option button is

compatibility mode  selected on the Multisession tab.

’ = Adisc that is compatible with Xbox cannot be created as a multisession disc.
F

3.1.1.4 1SO Settings
The ISO tab provides options for configuring the 1SO file system.

ISO 9660 is a system-independent standard. It can be read on all operating systems. The
following features apply:

m Permits eight characters plus three characters for the file extension (Level 1) or 31
characters (Level 2) for the file name including the file extension.

m Permits eight characters for the folder name.
m Restricts the maximum directory depth to eight levels (including root folder).
m The characters A-Z, 0-9 and the underscore (_) are permitted.
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In the ISO tab, in the area Relax Restriction, the restrictions imposed by the selected file
system can be relaxed. For example, you can allow a higher path level or more than 64

characters for the Joliet name.

- If the disc should be read on all operating systems, select ISO 9660 as the file
’ ? system and clear all check boxes in the Relax restrictions area.

An advisory message appears on the ISO tab in the Information area if the disc

’ ? cannot be read on all operating systems.
-+ Ifthe disc is to be used mainly on computers with Microsoft Windows and you
- ? want to use lowercase letters and/or foreign language characters for the file

names, select ISO 9660 + Joliet as the file system.

The following setting options are available on the ISO tab in the Data and File areas:

Selects the mode for the data. Mode 1 and Mode 2/XA are
available. Newer drives can easily read Mode 1 and Mode 2/XA
Drop-down menu CDs.

Data mode However, some older drives cannot read Mode 1 discs correctly.
In the case that the disc can to be read in any case on older
drives, select the Mode 2/XA format.

Selects the file system that is used for the data.

ISO 9660 only: ISO format alone is used.

ISO 9660 + Joliet: ISO format is used and is enhanced by the
Joliet standard.

ISO 9660:1999: The latest ISO format update is used. Among
other things it allows the use of 207 characters and a deeper
directory depth.

Drop-down menu
File system

Defines the possible length of the file name. Level 1 and Level
Drop-down menu 2 are available. In Level 1 the file name can be eight characters
Length of file name  long and the file name extension (e.g. *.doc) three characters. In
Level 2 the file name can be 31 characters long.

Drop-down menu

Defines the character set used for ISO names.
Character set
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3.2 Compiling a SecurDisc disc

SecurDisc is a technology with which you can create discs with special protection properties.
No special hardware is needed.

Discs that are created with Nero Burning ROM and the SecurDisc compilation type include
data integrity and reconstruction. Additional SecurDisc features include the possibility to
protect the data on your disc against unauthorized access with a password, to digitally sign
the disc, and to configure the data redundancy.

To be able to copy the protected data to your hard drive and to check the security of the data
you will need a special application named Nero SecurDisc Viewer. The Nero SecurDisc
Viewer is burned automatically to the SecurDisc disc and can be downloaded free of charge
at www.securdisc.net or www.nero.com.

’ = More information on SecurDisc technology can be found at www.securdisc.net.
F

To compile a SecurDisc disc, proceed as follows:

1. Select the desired disc format (CD, DVD, Blu-ray) from the drop-down menu in the New
Compilation window. (In the case that the New Compilation window is not opened, it can
be opened by clicking the New button on the main screen.)

= The selection list shows the compilation types that can be burned.
2. Select the desired compilation type for a SecurDisc from the selection list.

= The tabs with the configuration options that are valid for this compilation type are
displayed.
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SecurDisc Compilation

3. If you want to enable the password protection for all files:

1. Enable the Password protection check box on the SecurDisc tab.
= The SecurDisc — Protect Data window is opened.
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SecurDisc - Protect Data (3w

Enter a password ko protect the marked data against unauthorized
l . access,

Faor security reasons the passwaord should be at least 16 charackers

long and should contain letters and numbers.,

You can bype complete sentences to be used as a passward,

Warning: Remember your password! Without it you will be unable
ko access SecurDisc password protected docurments,

Passwiord; | Hide byping
b

Passward quality:

B e

Password confirmation:
****l

(] 4 ] | Cancel

2. Enter the desired password in the Password input area and then click the OK button.

When appropriate, a wizard offers suggestions in an additional Tips dialog box
when entering and selecting the password. The wizard estimates the security
level, i.e. the quality of the password, during entry.

4. If you want to sign the disc with a digital signature:

1. Select the Digital sighature check box on the SecurDisc tab.
= The SecurDisc — Digital Signature window is opened.
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SecurDisc - Digital Signature (3w

To digitally sign the disc vwou need a key,

Please select a private key from the lisk below,
Keep this key confidential and do not distribute it.

Send only the corresponding public key to the disc recipient,

- |

Browse, ..

Mero can create a digital key For wou in case vou do nok have
one ar wou wank ko create a new one.

Skart
(o] 4 Cancel

. If you have already created a digital key, click the Browse button and select the key.

3. If you want to create a digital key, click the Start button.

= The SecurDisc — Create Digital Key window is opened.

. Read the instructions and click the Next button.

= The SecurDisc Key Creation Process window is opened.

. Move your mouse at random until the creation process is complete.

= Nero Burning ROM uses the random data to create the SecurDisc key. You can
monitor the status of the creation process using the progress bar. The Next button is
enabled as soon as the process is complete.

. Click the Next button.
= The SecurDisc — Key Creation Completed window is opened.
. Enter a file name for the key you have created and click the Finish button.

= The SecurDisc — Digital Signature window is opened again and the selected key
appears in the drop-down menu.

. Click the OK button.

= The corresponding window is opened to inform you that the disc is being digitally
signed with the selected key.

. Click the OK button.
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“a - You can pass on the relevant public key to recipients to enable them to verify the
: ? signature.

5. If you want to enhance the burning speed by limiting the data redundancy or to configure the
data redundancy:
1. Select the Data redundancy check box on the SecurDisc tab.
= The drop-down menu is enabled.
2. Select the desired redundancy level.

-+, Ifthe Data redundancy check box is disabled, the disc will be filled completely
" ? . with copies of the chosen data and checksums. A display panel in the compilation
screen indicates the current redundancy level.

-+ Aredundancy level of 1,3 means no redundancy and a redundancy level of 9
E ? - means excellent redundancy.

We recommend a redundancy level of at least 2,5.

6. Click the New button.
= The New Compilation window is closed and the selection screen is displayed.
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SecurDisc Selection Screen
7. Select the files/folders that you want to burn from the File Browser area.

8. Drag the required files/folders into the Disc Content area on the left side.
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= The files are added to the compilation and displayed in the compilation screen. The
capacity bar indicates how much space is required on the disc.

You can selectively enable the password protection for individual files by marking

’ ? the desired file in the compilation screen and clicking the Protect button.

9. Repeat the previous step for all files that you want to add.

= You have compiled a SecurDisc disc with settings according to your requirements
and can now burn the disc.

See also
2 About Nero SecurDisc Viewer —115

3.3 Nero DiscSpan (UDF) Compilation and Nero DiscMerge Tool

With Nero Burning ROM you can compile and burn all types of files and folders to multiple
discs. The Nero DiscSpan feature for UDF compilations is useful when the data to be
burned is too large to fit on a single disc.

The number of discs to be used is shown in the compilation screen and you can switch the
disc type here. However, during the burn process you are allowed to alternate the disc types
(CD, DVD, Blu-ray Disc) regardless of which disc type you chose at the beginning.

When a single file exceeds the capacity of a disc, Nero Burning ROM can split such files
automatically. In addition, using the SmartFit feature integrated in Nero DiscSpan, Nero
Burning ROM can distribute files dynamically among several discs. The files are distributed
in such a way that the amount of needed discs is minimized by slightly rearranging the order
of files to optimally use the disc space available. Note that you can either enable splitting of
files or enable SmartFit.

The restore tool Nero DiscMerge and a file catalog is burned on the last disc of the set by
Nero Burning ROM. Nero DiscMerge provides an easy way to copy the content of the Nero
DiscSpan discs to your computer. Nero DiscMerge can also merge split files and restore the
original order of the files distributed by SmartFit.

3.3.1 Set Nero DiscSpan Options
The Nero DiscSpan tab provides configuration options for the Nero DiscSpan feature.

The following configuration options are available:

Enables the Nero DiscSpan feature. The compilation is burned
Check box to multiple discs, if necessary.

Enable Nero DiscSpan Nero DiscSpan can only be enabled, if on the Multisession tab
the No Multisession option button is selected.
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Enables the option that files that exceed a certain file size are
split if this is necessary to fill up a disc space. The original order
of the files is being kept.

Note, that you need Nero DiscMerge in order to merge split files
and folders. Nero DiscMerge is automatically burned to the last
disc.

Option button / Input field

Allow the splitting of
files which exceed

Enables the pure Nero DiscSpan feature (burns the compilation
Option button to multiple discs) without file splitting and without rearranging the

Allow Nero DiscSpan order of files.
without file splitting  Note, that the file size is therefore limited by the disc size at
least.

Enables the option that files are distributed dynamically among

several discs and not necessarily in the original order. The files
are distributed in such a way that the amount of needed discs is
minimized by slightly rearranging the order of files to optimally

) use the disc space available. Therefore, it is possible, that files

Enable SmartFit from one folder are to be found on multiple discs.

The original order of the files can be restored easily by Nero
DiscMerge. Nero DiscMerge is automatically burned to the last
disc.

Check box

Adds Nero DiscMerge to the last disc. Nero DiscMerge provides
an easy way to copy the content of the Nero DiscSpan discs to
Check box your computer.

Add Nero DiscMerge Nero DiscMerge can also merge split files and restore the
and file catalog to original order of the files distributed by SmartFit. Therefore, Nero

master disc DiscMerge is automatically burned to the last disc if the Allow
the splitting of files option or the Enable SmartFit option is
enabled.

3.3.2 Creating Multiple Discs with Nero DiscSpan

With Nero Burning ROM you can compile and burn all types of files and folders to multiple
discs. The number of discs to be used is shown in the compilation screen and you can
switch the disc type here.

In order to minimize the amount of needed discs, you can also split large files or re-arrange
the order of files to optimally use the disc space available.

To create an UDF compilation using the Nero DiscSpan feature, proceed as follows:

1. Select the desired disc format (CD, DVD, Blu-ray) from the drop-down menu in the New

Compilation window. (In case that the New Compilation window is not opened, it can be
opened by clicking the New button on the main screen.)

= The selection list shows the compilation types that can be burned.
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2. Select an UDF compilation type from the selection list.
= The tabs with the configuration options that are valid for this compilation type are
displayed.
3. Click the Nero DiscSpan tab.
= The Nero DiscSpan tab is displayed.

New Compilation X

&% o ~| [info | Multisession | Mero Discpan | autorun [LDF | Label | Dates | Msc | Bum

2 Opkicns

fa , i s i

DVD-ROM (UDF) @ Allow the splitting of fles which eoceed: 100 MB

- Allow Mero DiscSpan without fle spitting
ol Engble SmaritFit

DVD Copy Acld Mero DescMerge and e catalog to master disc Jast bumed disc)
6 Important: The master disc must be inserted first to restore split fies.
Hints

Different disc types can be mixed. As a result, any disc type can be wsed (CD, VD, Bharay)
regardess of the disc bype that was used to start the Nero DiscSpan compilation.

DYVD-Video

,,__ni

AVCHDNTM] video

New Compilation - DiscSpan (UDF)

4. Select the Enable Nero DiscSpan check box. Make sure, that on the Multisession tab the
No Multisession option button is selected.

’ - Discs that use the Nero DiscSpan feature cannot be created as multisession
“¥-  discs.
¥

-+, Nero DiscSpan options

) ;’ Allow the splitting of files which exceed: A files that exceed a certain file size
is split if this is necessary to fill up a disc space.
Allow Nero DiscSpan without file splitting: The pure Nero DiscSpan feature
(burns the compilation to multiple discs) without file splitting and without
rearranging the order of files.
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Enable SmartFit: Files are distributed dynamically among several discs and not
necessarily in original order.

5. Set the desired options on the other tabs.

6. Click the New button.

= The New Compilation window is closed and the selection screen is displayed.
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Total sz on ducis): 18.7 GE HL-DT-5T DVDRAM GHINELS

Selection Screen - DiscSpan (UDF)

7. Select the files/folders that you want to burn from the File Browser area.

8. Drag the required files/folders into the Disc Content area on the left side.

= The files are added to the compilation and displayed in the compilation screen. The
capacity bar indicates how much space is required by the DiscSpan compilation. On the
left an info field indicates how much discs will be burned.

-+ InNero Burning ROM, there is the option of defining filters for individual files or

" ? . folders by dragging files or folders into the compilation areas with the depressed
right mouse button. For instance, it is possible to filter for a particular type of file
(*.doc, *.xIs, *.txt) or select which type of file is not to be taken up in the
compilation area.

-1+ Itis very easy to hide files in data compilations for additional protection or for

" ? . security reasons so that they do not appear on the normal display. The files
behave in the same way as other hidden system files that are hidden by default,
but can easily be displayed. To hide files, right-click the required file, select the
Properties option and then select the Hide check box.
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9. If required, you can change the disc type.

= You have successfully compiled a data disc and can now burn this compilation.
During the burn process you will be prompted to insert a new disc whenever
needed. You are allowed to alternate the disc types (CD, DVD, Blu-ray Disc)
regardless of which disc type you chose at the beginning. If you have activated the
respective option, files which exceed a certain size will be split or files will be
distributed dynamically among several discs.

3.3.3 Copy Data with Nero DiscMerge

The tool Nero DiscMerge was burned on the last disc of the set - the so called Master Disc -
by Nero Burning ROM. Nero DiscMerge contains information about the content of the burned
Nero DiscSpan disc set. The amount of discs and which file or folder was burned to which
disc is also included in the information. Nero DiscMerge provides an easy way to copy the
files and folders to your hard drive by triggering the copy process and prompting you to insert
the single discs of the set. Using Nero DiscMerge you can be sure, that all files and folders
are copied and no disc is forgotten.

You can also exclude individual files from the copy process or select specific files to be
copied.

Furthermore, Nero DiscMerge can merge split files and folders that have been burned on
multiple discs if the split file feature has been used. If the SmartFit feature has been used,
Nero DiscMerge is useful to copy the distributed files and folders in original order. (If the
SmartFit feature is activated it is possible that files from one folder are to be found on
multiple discs.)

Therefore, we recommend using the comfortable Nero DiscMerge when copying Nero
DiscSpan disc content.

-+, Under Windows Vista and Windows 7 you need administrator rights to save the

- ? files to secure folders such as C:\Program files. Therefore, a User Account
Control message asking for administrator rights may appear with these operating
systems.

To copy the content of Nero DiscSpan discs, proceed as follows:
1. Insert the Master Disc - the last burned disc - into a drive.

= Nero DiscMerge starts automatically. The content, i.e. folder structure and files, of the
Nero DiscSpan disc set is displayed.
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| BEmp4 naro.mpd

4| [ % NeraExprass_Eng.chm
S| || MeroBurringRom_Eng.pdf
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Nero DiscSpan Merging Applic ation
Salact the Fles and Folders bo be copied,

Source drive: [ e ] -

Tarpat path: —
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8132007 4:29:08 PM
Q1612008 2:44:06 P
9/16/2008 2:25:29 PM
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"J' Copy Data

| & oo

Nero DiscMerge

. If the program does not start automatically, select the drive with the disc in
‘@ windows Explorer. You can start Nero DiscMerge manually by double-clicking the

NeroDiscMerge.exe file in the $Nero$ folder.

2. Select the copy target in the Target path input field by clicking the Browse button.

3. Select the check box preceding the folder or the file that you want to copy. Select a folder in

the left to show the contained files in the right.
4. Click the Copy Data button.

= The Copy Status window is opened.

= A message window is opened prompting for the first burned disc.

5. Remove the current disc and insert the first burned disc into the drive.

6. Click the OK button.

= The message window is closed and the copy process is started. Information about the
current step is displayed in the information area. A process bar indicates the progress
being made. When the content of this disc is completely copied, then the disc is ejected.
The message window is opened again prompting for the next disc.
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Copy Status [E=REER
Time Ewent
o 1/13/2010 1:38:26 PM Skarting to copy and merge the data on the disc...
o 1/13/2010 1:38:26 PM Copying files From disc 1...
Save..,
Current File: E:\imp# nero.mp4
Total progress: 50.7%
A
Copy Status

7. Insert each disc of the set in chronological burning order as requested by Nero DiscMerge.

= Once the copy process is complete, the message "Disc merging complete” is displayed

in the information area. The Cancel button changes to Close.
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Data Disc

r |
Copy Status =RECI X ]
Time Ewent
ﬂ 1/13/2010 1:38:26 PM Skarting to copy and merge the data on the disc...
o 1/13/2010 1:38:26 PM Copying files From disc 1...
ﬂ 111312010 1:35:33 PM Disc merging complete,
Save..,
Current File:
Total progress:
e

8. Click the Close button.

= The Copy Status window is closed.

9. Click the Close button.

= Nero DiscMerge is closed.
= You have successfully copied the content of multiple Nero DiscSpan discs to your

hard drive.

Copy Status - complete

If files has been split, they are merged together now. If files have been distributed
dynamically among several discs, they are in their correct folder in original order

now.

Check Point Media Encryption CD/DVD

With Nero Burning ROM and Check Point Media Encryption you can create discs with
special encryption security protection.

e

installed on your computer.

(2) You are allowed to create Check Point Media Encryption CD/DVDs.
(3) You have a special serial number.

.] This feature is only available if all of the following requirements are fulfilled:
(1) Check Point Endpoint Security Media Encryption, version R73 or later, is

Nero Burning ROM
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The procedure for compiling and burning a Check Point Media Encryption disc is basically
the same as the procedure for compiling and burning data discs. Be sure to select the
CD/DVD-ROM (Check Point) entry in the New Compilation window.

When starting the burn process, a window, which originates from Check Point Media
Encryption, will be opened. After entering security information, e.g. a password for
encryption as defined in your Check Point Media Encryption settings, Check Point Media
Encryption then encrypts the data. When the encryption is finished, the window is closed and
Nero Burning ROM continues the burn process. Depending on your Check Point Media
Encryption settings, a decryption tool is burned on the disc, allowing another user, who does
not have Check Point Media Encryption, to access to the data by entering the password.

The encryption of the data does not take place in Nero Burning ROM. Nero AG is
not responsible for the data encryption and the decryption tool. These features
are provided by Check Point Software Technologies.

3.5 Saving Data Track

With Nero Burning ROM you can save a data disc as an image file. The image file can later
be burned to a recordable disc. The result is a copy of the original data disc.

To save the data disc as an image file, proceed as follows:

1. Insert the data disc in a drive.

2. Click the Extras > Save Data Tracks menu.

= The Select Track window is opened. The tracklist shows you the sessions and data
tracks that are found on the disc. Due to the technical reasons, only the first data track of
the first session can be saved.
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Select Track @

Track, Start Length Mode

=4 ) CD-ROM
=49 Session 01 (56 ME)

N 5} Track 01: 00:02.00 06:18,02 (S6MEB), 50 9660/ Joliet/boatable (rmode 1)

= E: _MNEC DVD_RW MND-45714 -

Eject ] [ Refresh ] [ Save Track... ] [ Cancel

Select Track
3. Select the first data track.
4. Click the Save Track button.
= The Save As window is opened.

5. Select a file name and a storage location.

6. In the Save As drop-down menu, select the desired output format (ISO or NRG) for the
image file.

7. Click the Start button.

= The Progress window is opened and displays the progress made while saving. When
the save process is complete, the window is closed automatically.

= You have successfully created an image file starting from a data disc. Now you can
burn the image file to a disc.
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Audio CD and Audio Files

.1 Compiling Audio CDs

Using Nero Burning ROM you can create an Audio CD that contains music files. It can be
played on all standard CD players. To compile an Audio CD, source files with different audio
formats are automatically converted into Audio CD format before being burned.

'.' Some CD players cannot play CD-RWSs. Use CD-R discs to burn Audio CDs.

To create an Audio CD, proceed as follows:

1. Select the CD entry from the drop-down menu in the New Compilation window. (In the
case that the New Compilation window is not opened, it can be opened by clicking the
New button on the main screen.)

2. Select the Audio CD compilation type from the selection list.
= The tabs with the configuration options that are valid for this compilation type are

displayed.
Mew Compilation Iﬁ
[1 Sl v] | info |/ dudio €0 | cow options | Burn |
- General
« EU [ Mormalize all audio files
[ Mo pause between tracks
CO-ROM {150
L CD Text
Wirike: on
& ‘-rl Title:

—= Arkisk:

Additional Information

&r Coprright:

) Producer:
lized Maode CD
UPC/EAN code:

Date: 1f13fz010 B
&

Commenkts:
0 EXTRA

-

[ﬁ Nero Exprass ] ll—@' Open... l l N l le Cancel

Audio CD
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3. Set the desired options on the tabs.

ale

Audio CDs should always be burned using the disc-at-once method. This entry is
£ * selected by default.

4. Click the New button.
= The New Compilation window is closed and the selection screen is displayed.

5. Select the audio files that you want to burn from the File Browser area on the right side.
You can use the hard drive or an Audio CD as source of the audio file.

ale

:’} You can also choose an M3U playlist as a source.
¥

6. Drag the desired audio files into the Disc Content area on the left side.

= The files are added to the compilation and displayed in the compilation screen. The
capacity bar indicates how much space is required on the disc.
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Compilation screen - Audio CD
7/ . Repeat the previous step for all audio files that you want to add.
8. Customize the properties of the audio file to suit your requirements.

= You have successfully compiled an Audio CD and can now burn this compilation.
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See also
2 Selection Screen —19

4.1.1 Customizing Properties of the Audio File

You can display and/or make changes to the audio file properties on the Track Properties,
Indexes, Limits, Splits and Filters tabs of the Audio Track Properties window. To open
the window, mark an audio file in the compilation screen for Audio CDs and click the
Properties button.

4.1.1.1 Track Properties Tab

On the Track Properties tab you will find basic information on the selected file in the
Source information area. To open the window, mark an audio file in the compilation screen
for Audio CDs and click the Properties button.

Audio Track Properties Tl
Track Properties | Indexes, Limits, Spit | Fiters
Souwrce infamation
I File MP3 44100HZ 1928Bis Stereo Track No14mpd
Frequency: 44,100 Hz
Channels: 2
Resalution: 16 bits
Propesties
Tithe {CD TEXT) P31 44100HZ 192KBits Stereo Track MNo14)
Atist (CD TEXT): MP3 44100HZ 152KBits Stereo Track Mald
Pause 2 lm -
Intemational Standard Recording Code
{ISAC)
Protection

Cross fade with previous frack

| ok || Cancel

Track properties

The following input areas are available in the Properties area:

Defines a title which is saved as CD Text. CD players that support
Input field CD Text show the title name entered here.

Title (CD Text) Only Latin characters can be displayed as CD Text. CD Text can
only be written in disc-at-once mode.
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Input field
Artist (CD Text)

Input field
Pause

Input field

International
Standard
Recording Code
(ISRC)

Check box
Protection

Check box

Cross fade with
previous track

Audlio CD and Audlio Files

Defines the artist which is saved as CD Text. CD players that
support CD Text show the artist's name entered here.

Only Latin characters can be displayed as CD Text. CD Text can
only be written in Disc-At-Once mode.

Defines the length of the pause in seconds or frames between the
selected audio file and the previous one.

Identifies the CD title using a 12-character digital code. The ISRC is
entered in the subcode and included silently.

If you do not know the ISRC, you should leave this input field blank.

Sets the copy protection bit for the corresponding track on the Audio
CD. As most CD recording applications simply ignore this bit, copy
protection cannot be ensured. A warning message will be opened in
Nero Burning ROM while copying an Audio CD with copy protected
tracks.

Defines a crossfade between this and the previous audio file. You
can specify the length of the crossfade in seconds or in sectors.
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Audio CD and Audio Files

On the Indexes, Limits, Split tab you can set and delete indexes and split audio files to
create two or more shorter ones. The tab consists of the Oscilloscope and Positions areas.

[ Audio Track Properties

Osclloscope

Postions

0:00.00 {Start
3:53.42 (End)

[ |

) Cmes ) [ 5

Indexes, Limits, Split Tab

Audio files are displayed graphically in the Oscilloscope area. The following configuration
options are available in the Positions area:

Selection lists
Start/End

Button
New Index

Button
Edit

Button
Delete

Button
Split

Shows the positions for the beginning and end of the audio file on
the CD.

Sets a new index position at the selected position. For the CD player
this is the position from which a new song starts, and the player can
also jump to it directly. However, not all CD players support this
feature.

Opens the Edit track limit dialog box.
You can enter the exact position of a split.

Deletes a selected index.

Splits the audio file at the marked position.
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Button Plays the audio file from the marked position.
Play During playback, the Stop playing button is displayed.
Button Stops playback of the audio file.

Stop playing If playback is stopped, the Play button is displayed again.

Button
Split at Index Splits the audio file at the set index positions.
Positions
Button . . I
Enlarges the graphical representation of the audio file.
Zoom In
Button . . A
Reduces the graphical representation of the audio file.
Zoom Out
Button . . . . I
i Displays a graphical representation of the entire audio file.
Full View
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4.1.1.3 Filters Tab

Audio CD and Audio Files

The Filters tab includes filters that improve or change the quality of the music. The so-called
non-destructive procedure is used for processing, i.e. the actual recording is not changed,
but flags are simply set that can be canceled at any time. No additional audio data is
created. The audio files on hard drive are not modified during this procedure.

Audio Track Properties

Track Properties | Indexes, Limits, Split | Fitters

Womaize
Dechick Nomalization method: RAMS -|
Hizs Reduction ' :
| Fade In Percent: 20 -
Fade Out - : :
| Steren Widening
Karsoke This fiker may be used to set the volume of a frack to a standard volume. it may be
Echo ws=eful to adust the volume of several tracks that were read from different sound input
devicas.
| Equalirer
The RMS method (oot mean-aguare) sets the mean voluma of the track to the given
value, The madmum method sets the wolume to a value which avoids clipping.

| Test Selected Fiters

[

| ok || Cancel

Audio Track Properties window, Filters tab

The following configuration options are available in the Audio Track Properties window:

Check box
Normalize

Check box
Declick

Check box
Hiss Reduction

Check box
Fade In

Check box
Fade Out

Sets the volume of an audio file to a preset value. This filter can be
useful to bring the volume of files originating from different sources
into line with one another.

Removes clicking and scratching noises, such as those on old LPs
for example.

Reduces or removes the hiss on an audio file. All frequencies
below a certain threshold (hiss level) are removed.

Fades in the volume of an audio file from zero to full volume. This
filter can be useful for shortening files.

Fades out the volume of an audio file from full volume to silence.
This filter can be useful for shortening files.
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Check box Increases/reduces the stereo effect of an audio file. This filter only
Stereo Widening  works if the original file was recorded in stereo.

Check box Fades out the vocals on an audio file. This is done by fading out
Karaoke the parts of a song that are the same in both stereo channels.
Check box o
Adds an echo to the audio file.
Echo
Check box Opens an equalizer so you can change the volume, bass, and
Equalizer pitch in different frequency ranges.

Plays the audio file and applies the activated filters. During
playback, the configuration options for the filters can be changed,
allowing the effect to be controlled.

Button
Test Selected Filters

4.1.2 Defining Options

4.1.2.1 Audio CD Settings
The Audio CD tab provides options for setting the Audio CD.

[ 3
Mew Compilation Iﬁ
e = | [1nfo [¢Audia €5 | cpa options [ Bum |
- General
[ Ij_j [T Mormalize all audio files
[IMo pause between tracks
CD-ROM (500

i CD Text

Write on D

, il Title:

Arkist:
Additional Information

@r Copyright:

. Producer:
Mixed Mode CD

UPC/EAN code:
Date: 1f13fz010 [E~
«f
Comments:
CD EXTRA
lﬁ Mero Express l L_g open... l l [ew l le Cancel

Audio CD Tab

The following configuration options are available on the Audio CD tab in the General area:
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Check box Enables a filter that brings the volume of the audio files to be
Normalize all audio  burned into line with one another. This is particularly
files recommended if the audio files originate from different sources.

Allows the audio files to merge into one another on the Audio CD
without a pause (just like in live recordings).

If the check box is cleared, there are pauses of two seconds

Check box o
between the audio files.
No pause between _ .
tracks We strongly recommend using the disc-at-once mode.

Otherwise the zero pause length may not be supported by all
recorders and/or a very short clicking noise may be heard
between tracks.

The following configuration options are available in the CD Text area:

Enables the option for writing CD Text. With CD players that
Check box support CD Text, the title of the CD, the name of the audio file as
Write on CD well as the name of the artist appear in the display.

CD Text can only be written in disc-at-once mode.

Input field
Title

Defines the label of the Audio CD.

Input field
Artist

Defines the artist.

You can also enter additional information about the Audio CD such as the producer or
comments.

4.1.2.2 CDA Settings

The CDA Options tab provides options for configuring CD-DA files on the Audio CD. The
CDA file strategy area allows you to select the strategy that Nero Burning ROM should use
for handling selected audio files from a source Audio CD. In general there are two methods:

m Read the audio file and store it in the cache temporarily. The Audio CD can be burned in
disc-at-once mode, which supports CD Text.

m Create a reference to the audio file and read it shortly before burning (track reference).
The Audio CD can only be burned in track-at-once mode.

-+, Toadd tracks from a source Audio CD to your audio compilation, we generally

C ? recommend the following alternative:
Rip the source Audio CD to hard drive (see Copy Audio CD to Hard Drive— 57).
Ideally, save the tracks in the lossless FLAC format. Then proceed by adding the
audio files to the audio compilation.
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The following setting options are available on the CDA Options tab in the CDA File

Strategy area:

Drop down menu entry
Diskspace strategy

Drop-down menu entry
Tempfile strategy

Drop-down menu entry
Reference strategy

Drop-down menu entry

Device dependent
strategy

Saves the audio files temporarily to the Nero Burning ROM
cache.

If there is no space available, a reference is created to the audio
file and is not read until shortly before burning. This entry is
selected by default.

Saves the audio files temporarily to the Nero Burning ROM
cache.

If there is no space available, an error message appears.

Creates a reference to the audio file and reads it shortly before
burning. The source medium can only be a CD/DVD drive, not a
recorder. The disc can only be burned in track-at-once mode.

Creates a reference to the audio file if a CD/DVD drive is
available. Otherwise the tempfile strategy is used.

The following setting options are available on the CDA Options tab in the Drive area:

Selection list
Drive

Drop-down menu
Read speed

Check box

Cache track on hard
drive before burning

Lists recognized drives and burners.

Selects the speed at which the CD is read.

Saves the audio file in the cache before burning.

The following setting options are available on the CDA Options tab in the Advanced area:

Check box

Remove silence at the
end of audio tracks

Removes silence at the end of individual audio files, i.e. music
tracks transition smoothly from one to the next. This check box is
selected by default.

To avoid unwanted effects set the pause length to 0 when
clearing this check box (to set the pause length see Track
Properties Tab— 46).
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4.2 Mixed Mode CD and CD EXTRA
With Nero Burning ROM you can compile CDs that include both audio and data files.
The following compilation methods are available:
= Mixed Mode CD
m CD EXTRA

A Mixed Mode CD includes the data and the audio files in one session. CD EXTRA includes
the audio files in the first session and the data files in the second session.

The procedure for compiling the audio and data files is basically the same as the procedure
for compiling data or music CDs. Please be sure to select the corresponding entry in the
New Compilation window. The selection screen includes a compilation area for audio files
and one for data files. The compilation can only be burned if files have been added to both
the audio and the data compilation area.

See also
Selection Screen —19
2 Compiling Audio CDs —44
= Compiling Data Disc —22

4.2.1 CD-Extra Settings
The CD EXTRA tab provides configuration options for albums.

The following information is available in the Info area:

Display panels Displays information on the compilation.

The following configuration options are available in the Album area:

Input field Defines a name for the aloum. This is particularly useful when
Album identification the album is to comprise several CDs.

Input field
Number of volumes in Defines the number of discs that the compilation should contain.
album
Input field
Album sequence Defines the album number of the current disc.
number
Button Opens the CD EXTRA Pictures window where you can select
Pictures the pictures for the front and flipside of the CD and define the
ictu

picture format.

The following configuration options are available in the Localization area:
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Displays available languages. When you select a language, you

Display panel X ; i
can add the title for the album in the Album title text box. Each
Languages language can contain a different title.
Button Opens the New Language window where you can select a new
Add language from a country list.
Button
Deletes the selected language.
Delete
Input field Adds an album title to the language highlighted in the
Album Title Languages selection list.

4.3 Automatic Music Recognition

With Gracenote MusiclD Nero Burning ROM can identify music files. So called metadata
such as artist, title, and genre are accessed from the Gracenote Media Database and
displayed in Nero Burning ROM. The identified metadata is written to the music file and is
then available.

Identification is possible for single audio files as well as complete original Audio CDs.

If the metadata of the Audio CD is not yet included in the database then you can enter it and
make it available. The metadata is sent to Gracenote and added into the database.

With Gracenote you can have audio files identified out of any sort of audio compilation. This
is particularly useful when audio files are not named or are only partially named. The
metadata that is made available by Gracenote is used for the compilation and is written into
the audio files. In this way your music collection is correctly tagged with all information.

During the following actions, original Audio CDs can be automatically identified in Nero
Burning ROM with Gracenote MusiclD.

m Copying Audio CD
m Saving Tracks from the Audio CD to Hard Drive

Music recognition technology and related data are provided by Gracenote®.
Gracenote is the industry standard in music recognition technology and related
content delivery. For more information, please visit www.gracenote.com.
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4.3.1 ldentifying Audio Files

You can have the added audio files in the music compilations identified with Gracenote and
access metadata such as artist and title from the Gracenote Media Database.

To do this, proceed as follows:

1. Select the type of compilation to burn a music CD.

= The compilation screen is displayed.
2. Add audio files from the hard drive to the music compilation.
3. Select one or more audio files in the compilation.
4. Right-click to open the context menu.

5. Select the Get metadata entry.

= The audio files are analyzed and the required information is sent to Gracenote. The Edit
Meta Data window is opened. The metadata received by Gracenote is displayed in the
New Info area.

Get Metn Data oo

< Forame Status
Cd O (T estdaten’\dudc Ve y Wordssorth_ Soyal Phiharmonic Orchesirafieethoven_ Symphones [Dsc 11101 - Barry .. Exact
Cd iz \Tesidaten' o Yy Wordssorth_ Rovel Phiharmonic Orchesira-flesthoven_ Symphonies [Disc 1702 -Barry .. Beact
¢ DO \Testdaten’tudofamy ‘Wordssorth_ Aoyal Phifharmonic Orchesira-Sesthoven_ Symphomes [Disc 103 -Bary ... Ewact
= Oz {Testdaten’\tudioBarry Wordsmorth_ Royal Phifarmonic Orchesira-Besthoven_ Symphones [Disc 1704 -Barry ... Eanct

Metadats syrchroned
Oid Info wgw Info
| Tirack: 3 Tragk: 7
T Besthoven: Tithes: B fhorven: Symghory #1100 €, Op. 21 -2
Arish Barry Wordsworth: Arbst: Banry Wordsworth: Royal Phiharmanic Ord
Alum: Bewthouen: Al Eeethoven: Symphonies 2187
Berre: Other Classica Gere: (e Cassical -
| Year: ] Year: 1555
| Actust il fie rame{s] L Aty i | Emnoet |

Edit Meta Data window

6. If necessary, edit the metadata, e.g. track number, title, artist, album title, year, and genre.

7. Click the Apply button.
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= The Edit Meta Data window is closed.

= The metadata is written into the audio file and accordingly shown in Nero Burning
ROM. If the Adjust all file name(s) check box is selected, the file on hard drive is
renamed accordingly (if technically possible).

4.4 Copy Audio CDs to Hard Drive

With Nero Burning ROM you can save audio files from an Audio CD to the hard drive. In the
process, the files are encoded, i.e. converted into a format that the computer can read. The
audio file is usually compressed.

The Audio CD can be automatically identified with Gracenote MusicID. So called metadata
such as title, genre, and track title are accessed by the Gracenote Media Database and
associated to the tracks. If available, Album art is also displayed and associated to the
tracks. That way you have audio files that are accurately and fully named after the encoding
process.

Music recognition technology and related data are provided by Gracenote®.
Gracenote is the industry standard in music recognition technology and related
content delivery. For more information, please visit www.gracenote.com.

’ = Audio files from copy-protected Audio CDs cannot be saved.
F

To save audio files, proceed as follows:
1. Click the Extras > Save Audio Tracks menu.

= The Save Audio Tracks to Hard Drive window is opened.
2. Insert your Audio CD into a drive.

= The disc is being analyzed and the required information is sent to Gracenote. If an
exactly matching metadata entry is found in the Gracenote Media Database then that
metadata entry will be used and displayed.

= |f several metadata entries are found or the found entry is ambiguous, then the Matches
window is opened and the metadata etries in question are displayed.

3. Select the metadata entry that matches your Audio CD.

4. Click the Send New Data button if none of the metadata entries match your Audio CD.
= The Edit MetaData window is opened.
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Edit Meta Data =)
|
Track Tifle Artst Length PR
Symphones Na, 152
1 Beethoven: Symphony #1InC... Ludwig ¥an Beethoven 00:09:13
2 Begthoven: Symphony #1InC... Ludwig Van Beathaven 00:08: 25
3 Beethoven: Symphony #1InC... Ludwig Yan Beethaven Do:03:21 abum Artist:
2 5. ®1CDur (op. 21) 4, Adagio... Ludwig Van Beethaven 00:05:50 Ludwig Van Besthaven
5 Beethoven: Symphony #2InD... Ludwig Van Beethoven DO: 13:03 Vear
& Begthoven: Symphony #2 InD... Ludwig ¥an Beethoven o130 |
7 Beethaven: Symphony 22 InD... Ludwig Van Beethoven D3:03:43
] 5, 220-Dur {op. 21) 4, Alegro...  Luthwig van Besthaven 00:06: 29 Genre:
_ﬂassﬂd Era hd
Browse... ‘
Advanced Optians | | Submit | Cancel

Edit MetaData

‘a- The Edit Meta Data window also opens if no matching entry is found in the
-9 database but you want to enter the metadata and make it available.
¥

5. Edit the audio track metadata (Title and Artist) by clicking in the track list.

6. Edit the Audio CD metadata (Album Title, Artist, Year, and Genre as well as Aloum Art)
on the right side.
7. Click the Advanced Options button if you want to add additional information.

= The Gracenote MusiclD Information window, which originates from Gracenote, is
opened. After entering the additional information you have to close this window so that
the Edit MetaData window is displayed again.

8. Click the Submit Data button.

= |f you have changed the Audio CD's metadata or filled it in for the first time then the
changes are sent to Gracenote and entered into the Gracenote Media Database.

= The Edit MetaData window is closed and the information is passed on to the Save
Audio Tracks to Hard Drive window.

lm Nero Burning ROM 58



Audio CD and Audio Files

B Save Aidia Tracks to Hasd Drive = & -
SOUreE | Output
Sgurce drive: & F: HLDT-5T BD-RE. GEW-H20L bl & Betresh
¢ Tithe Artet lergth  Copy Stabus J" Edt...
a1 Besthoven: Symphony #1 InC, Op. 21 - 1...  Bary Wordsworth: Bow,., 09213 X
ik Basthowen: Symphony &1 InC, Op. 21 - 2., Bary Wordswerth: Roy, 0825 Abum:
73 Besthoven: Symphony #1100, Op. 21-3...  Bamy Wordsworth: Boy., 03221 Beethowen: Symphonies [L
o4 Basthoven: Symphony &1 In G, Op. 21 -4, Bary Wordsworth: Roy,., 05550 Artist:
S| B Basthowsn: Symphony 22 In0, Op. 36 - 1., Bamy Wordswerth: Boy... 1303 Earry Worcksorth: Royal F
76 Beathoven; Symphony #2 Tn D, Op. 36 - 2...  Bamy Wordsworth: Roy,., 11530
w7 Basthowsn: Symphony 22 In0, Op. 36 - 3., Bary Wordsworth: Roy.., 03043 fear
7l e Beethoven; Symphony #2 In D, Op. 36 - 4...  Bamy Wordsworth: Roy.., 06229 199%
GEn
Cther Classical -
o
; g Loag Caver...
- -
e ) o o W) @ 00:00:00
Q -

Save Audio Tracks to Hard Drive

9. Select the tracks that you want to save on the hard drive.

10. Click the Output tab.

11.
12.

13.
14.

= The Output tab is opened.

In the File Format drop-down menu, select the target file's audio format.

Choose a method for creating the file name in the Mode for Creating File Names drop-
down menu.

Define other settings according to your preferences.

Click the Copy button.
= Conversion starts. A folder with the album name is created in the desired folder. The

audio files are saved in this folder and named according to the method you chose. A
playlist file is created and saved in the same folder. Metadata that is identified with
Gracenote is written into the audio file.

The Progress window indicates the saving progress. When the save process is
complete, this window is closed automatically.

15. Click the Close button.

= The Save Audio Tracks to Hard Drive window is closed. You have saved audio
files.
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441 Save Audio Tracks to Hard Drive Window

Define the settings for audio files to be saved to the hard drive in the Save Audio Tracks to
Hard Drive window. The window is opened by clicking the Extras > Save Audio Tracks

menu.
B Save Ausdio Tracks to Haed Drive == =
SOros | Cutput
Sgurce drive: &= F: HL{DT-5T BO-RE GEW-HZOL b ;$ Befrash |
4 Tithe Artist length  Copy Stabus J‘I' Edt... '
v 1 Besthoven: Symphony #1 InC, Op. 21 - 1...  Bary Wordsworth: Boy,., 0913 X
|2 Basthorsar: Syrnphony #10InC, Op 21 - 2, Bary Wordswarth: By, 08:25 A
“IE Besthowven: Symphony #11nC, Op. 21- 3. Bamy Wordsworth: Floy.., 0321 Beethowver: Symphonies [L
|4 Basthoen: Symaphiony #0 TnC, O 21 -4, Bairy Wordsworth: Reg',., 0550 Arrist:
| B Basthowsn: Symphony #2 In0, Op. 36 - 1., Bamy Wordsworth: Bog... 13203 Eearry Woeckworth: Foval F
v B Benthowen: Symphony #2 InD, Op. 36 = 2...  Bary Wordsworth: Row,., 11230
Cal Basthowen: Symphony #2 InD, Op. 36 -3, Bary Wordsworth: Boy.., 03043 Tear
7B Bosthaven; Symphony #2 In 0, Op. 36 - 4...  Bamy Wordsworth: Row,., D629 199
GEne:
Oithyer Clamsical v
"
Lid ™
Q00000 .
0 -

Save Audio Tracks to Hard Drive - Source

The following setting options are available:

Tab
Specifies settings for the source of the audio files.
Source
Tab _ , : .
Sets output files configuration options.
Output
Button
Starts the copy or save process.
Copy
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4.4.1.1 Source Tab

The Source tab displays the audio files on the Audio CD. The functions of the control
buttons correspond to the familiar control buttons on CD players.

The following setting options are available:

Drop-down menu ) . .
. Selects the drive where the Audio CD is inserted.
Source drive

Displays the tracks on the Audio CD. You can select individual tracks

Title Selection List to copy by selecting the respective check box.

Sends a new query to the Gracenote Media Database and
completes the Audio CD's metadata including artist, title name, and
genre if a matching entry exists in the database.

Button
Refresh

Opens the Edit Meta Data window. Here, you can edit the Audio CD
metadata sent by Gracenote. You can enter the metadata if no entry
for your Audio CD exists in the Gracenote Media Database. This
metadata is sent to Gracenote, and added to the Gracenote Media
Database.

Button
Edit

Input fields

_ Displays or specifies metadata for the album, artist and year.
Album/Artist/Year

Selection list , .
Displays or specifies the genre.
Genre
Cover area Displays Album Art, i.e., the cover of the Audio CD.
Button . .
Loads an alternative cover from your hard drive.
Load Cover
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4.4.1.2 Output Tab
You can define the properties of the audio files to be created on the Output tab.

[# Save Audia Tracks to Hard Drive =] &
Source | Cutput
Target
Cutput directory: by s e I o WLsS | Erovess...
Fie name creation mode [Track rumbser ~Titke - Arst *

+ | Aytomaticaly generate a playist of stoned sudio rads

Playkat format; LT -
Format

Fie format: | Wit AALC () k2

i |Mero AAC 128 ko %

Hero AAC Audio+ Features
of | Foroe compatindity with Pod

HFP3 Features

Album Art

o | Add Aloum Art to file IF svaiabie

Copy Audio CDs to Hard Drive - Output

The following setting options are available:

Input window

) Selects the storage location for the output file.
Output directory

Button . .
B Opens a browser window where you can select a storage location.
rowse

Drop-down menu

Mode for creating
file name

Selects the method to be used for creating the name of the output
file.

Check box Creates a playlist of the saved audio files. A playlist is a list of the
Automatically ripped audio files in the right order with the right metadata. It is a
generate a playlist very convenient tool - you simply have to select the playlist to add all
of stored audio  the audio files in contains to an audio compilation or a playback
tracks application.
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Drop-down menu

) Selects a format for the playlist.
Playlist format

Selects the output audio format for the selected audio file. The
Drop-down menu selected file format is available as the first entry the next time it is

File format called up. You can choose between Nero AAC Audio, MP3 Audio,

Selects the bitrate for the selected audio file format. If the bit rate is

small, less data is transferred. The file is then small, but quality is

lower. If the bit rate is high, more data is transferred. The file size is
Drop-down menu then large, but the quality is high. A value of 128 for MP3 files is near
CD quality. For the MP3 Audio file format you can also select if you

Quality
want to create an MP3 file or an mp3PRO file.
Only available if you selected the Nero AAC Audio or MP3 Audio
file format.
Check box ol Makes Nero AAC Audio available for an iPod.
Forciv?;Tgsg ity Is only available if you selected the Nero AAC Audio output format.

Disables the ID3v2 Unsynchronization during the decoding process.

ID3v2 Unsynchronization is a part of the MP3 decoding process. It
Check box increases the chance that the MP3 file can be played even with old
. software or hardware that does not support ID3v2. However, some
Disable ID3v2 ) .
L devices that support ID3v2 do not support ID3v2 Unsychronization.
Unsynchronization . ) ) .
The display of images or text tags might be corrupt on such devices
when playing MP3 files with unsynchronized ID3v2. Select the check
box if you have encountered such problems.

Check box Adds Album Art to the files. Album Art works for example as a mini
Add Album Art to | view in the Explorer. Adding Album Art increases the file size.

file if available Only available if Album Art is available or chosen for this Audio CD.

45 Convert Audio File Format

With Nero Burning ROM you can convert an audio file into another format, i.e. transcode the
audio file (e.g. from WAV to MP3).

The following formats are usually available (available formats may depend on the source
format):

m AC3: You can specify the bit rate for this audio format
m AIFF: See Encoding Options AIFF— 65
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m FLAC: It is not necessary to specify any settings for this lossless audio format
m MP3 (Lame Encoder): See Encoding Options MP3— 66

MP3/mp3PRO: See Encoding Options MP3/mp3PRO— 67

Nero AAC Audio: See Encoding Options Nero AAC Audio— 69

OGG: See Encoding Options OGG— 70

WAV: See Encoding Options WAV— 65

WMA: You can set different profiles for this audio format

4.5.1 Encode Files Window
In the Encode Files window, the audio files that are to be encoded are selected and the
properties of the output are defined. You can open the window via the Extras > Encode
Files menu. The window consists of a selection area and the Properties area.

(5" Encode Files |
Fies to be encoded: Show full pathel
I Source Ext Target Ext Duration Status

7 - Barry Wordsworth Roval Phih... mp3 7 - Barry Wordsworth Roval Phil...  wav  0:07.20.058 Mot done
5 - Barry Wordsworth Roval Phih,.. aif 5 - Barry Wordsworth Roval Phil..,  wav  0:12.51,552 Mot done

Adc - Remaove | | Remove Al | | Reset Status

Properties for fle ",..\5 - Barry Wordsworth Royal Phibarmonic Orchestra - Beethowen Symphony #7In A, Op. 52 - 1. P...'

Oytput fie format: Windows PCH (*,wav; =.wave) - | | Settings... |

Target file C:\Users \Administrator Music\s - Barry Wordsworth Rioyal Philha |_W-N=E |

Source file infio: Aff file, Mumber of channels: 2, Sampling rate: 45100 -
= | | Close

Encode Files Window
The following configuration options are available in the selection area:

List

, Displays the selected files.
Files to be encoded

Check box Displays the full source and destination paths for the files in the
Show full paths Files to be encoded list.

lm Nero Burning ROM 64



Audlio CD and Audlio Files

Opens the browser window where you can select a file to add it to
Button the list of files to be encoded.

Add Clicking on the little triangle allows you to select audio files using
Nero MediaBrowser.

Button .
Removes the selected file.
Remove
Button . . .
Removes all files from the list of Files to be encoded.
Remove All
Button

Resets the status of the selected file back to Not done.
Reset Status

The following configuration options are available in the Properties area:

Drop-down menu

) Selects the output audio format for the selected audio file.
Output file format

Button Opens a window where you can define options such as bit rate
Settings and frequency for the output audio file.

Display panel , , ) )

. Displays the storage location of the output file or output files.
Target file
Button . .
Opens a browser window where you can select a storage location.

Browse

Display panel

o Displays information on the selected audio file.
Source file info
The following buttons are available for the encoding process:

Go Starts the encode process.

Close Closes the window.

4.5.2 AIFF and WAVE Encoding Options

Nero Burning ROM can encode audio files in AllIF or WAV formats.

Set options in the AIFF/Wave window that you can open in the Encode Files window via the
Settings button. Ensure that you have selected AIFF or Wave as the Output file format.
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The following setting options are available in the AIFF or Wave window:

Specifies the scan rate per second and thus determines the

Drop-down menu _ i
frequency of scanning. The higher the frequency, the more

Frequency frequently scanned.
Drop-down menu Specifies the scan accuracy and thus determines the quality of the
Bits individual scanner. The higher the bit sign, the more accurate.

Drop-down menu

Specifies which channels are recorded.
Channels

4.5.3 MP3 Lame Encoding Options

With Nero Burning ROM you can encode audio files in MP3 formats using the Lame Codec.
Set these options in the MP3 Settings window that you can open in the Encode files
window via the Settings button. Ensure that you have selected Lame MP3 Encoder as the
Output file format.

The following encoding options are available in the Settings area:

Selects a constant bit rate, i.e. the data flow per unit of time and
the quality of the saved data are the same over the entire audio
Drop-down menu file. If the bit rate is small, less data is transferred. The file is then
Constant Bit Rate  Small, but quality is lower. If the bit rate is high, more data is
transferred. The file size is then large, but the quality is high. The

default value of 128 for MP3 files is near CD quality.

Selects variable bit rate, i.e. the data flow per unit of time - and
thus the quantity of the saved data - adapts to the dynamics of the
audio file. The bit rate, for example, can be lowered at quieter
points in the track.

Select your desired quality level in the drop-down menu.

Drop-down menu
Variable Bit Rate

The following encoding options are available in the Expert settings area:

Specifies the encoder quality. These settings specify whether you
Drop-down menu place more value on fast encoding (lowest/fastest) or more value
Encoding quality ~ on a superior psychoacoustic encoder model for the very best
results (highest/slowest).

Check box Sets the original bit_in_ the music file, which differentiates between
i , the copy and the original.
Original bit . . . -
Check box selected: Original bit = 1, i.e. original.
Check box cleared: Original bit = 0, i.e. copy.
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Check box Sets the private bit in the music file. It is reserved for the user and
Private bit is only used for informational purposes.

Sets the copyright bit in the music file, which identifies protected
Check box content.

Copyright bit Check box selected: Copyright bit = 1, i.e. protected.
Check box cleared: Copyright bit = 0, i.e. unprotected.

Check box Sets a checksum in the music file to ensure that transfer errors are
Write CRC detected.

4.5.4 MP3 and MP3PRO Encoding Options

With Nero Burning ROM you can encode audio files in MP3 and MP3PRO formats. Set
these options in the MP3PRO window that you can open in the Encode files window via the
Settings button. Ensure that you have selected MP3/MP3PRO as the Output file format.

-

=

mp3 / mp3PRO
Fraunhofer | ... .
Integrierte Schaltungen
Settings
Encoding quality: [Medium v]
() Constant bitrate: MP3 : 128 kbit, 44100 Hz, stereo
i@ Variable bitrate: [Medium quality v]
[~ Enable mp3PRO | ok || cancel |[ Bxpert<< |
Expert settings
Original bit allow intensity stereo coding
[ Private bit Allow downmix
[| copyright bit
[] Write CRC Padding: 150 B

MP3PRO window

The following encoding options are available in the Settings area:
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Drop-down menu
Encoder quality

Check box
Constant Bit Rate

Check box
Variable Bit Rate

Specifies the encoder quality. Fast, Medium and Highest are
available. These settings specify whether you place more value on
fast encoding (Fast) or more value on a superior psychoacoustic
encoder model for the very best results (Highest).

Selects a constant bit rate, i.e. the data flow per unit of time and
the quality of the saved data are the same over the entire audio
file. If the bit rate is small, less data is transferred. The file is then
small, but quality is lower. If the bit rate is high, more data is
transferred. The file size is then large, but the quality is high. The

default value of 128 for MP3 files is near CD quality.

In the drop-down menu, select the Options that affect the bit rate:
scan rate per second in kBit, scan frequency per second in Hertz
and the channels.

Selects variable bit rate, i.e. the data flow per unit of time - and
thus the quantity of the saved data - adapts to the dynamics of the
audio file. The bit rate, for example, can be lowered at quieter
points in the track.

Select your desired quality level in the drop-down menu.

Note that not all players are able to show the correct length of MP3
files that were recorded with variable bit rate.

The following encoding options are available:

Check box
Enable MP3PRO

Button
Expert

Specifies the encoder method used. If you select the check box,
an MP3PRO file is created (*.mp3 file extension).

If you clear the check box, an MP3 file is created (also *.mp3 file
extension).

Opens the advanced area where you can configure Expert
Features.

The following encoding options are available in the Expert Features area:

Check box
Original bit

Check box
Private bit

Sets the original bit in the music file, which differentiates between
the copy and the original.

Check box selected: Original bit = 1, i.e. original.
Check box cleared: Original bit = 0, i.e. copy.

Sets the private bit in the music file. It is reserved for the user and
is only used for informational purposes.
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Check box
Copyright bit

Check box
Write CRC

Check box

Allow intensity stereo
coding

Check box
Allow downmix

Drop-down menu
Padding

Sets the copyright bit in the music file, which identifies protected
content.

Check box selected: Copyright bit = 1, i.e. protected.
Check box cleared: Copyright bit = 0, i.e. unprotected.

Also sets a checksum in the music file to ensure that transfer
errors are detected.

Uses a special codec at high frequencies that only saves the

directional information and volume.

Mixes two stereo channels down to one mono signal. This option
is useful when the output data is of such poor quality that a poor
stereo signal is to be expected. An increase in quality is expected
when downmixing to mono.

Selects a padding type for MP3 blocks. We recommend padding
type ISO that pads MP3 blocks according to the 1SO specification.

4.5.5 Nero AAC Encoding Options

Nero Burning ROM can encode audio files in the Nero AAC Audio format.

Set options in the Nero AAC Encoder Settings window that you can open in the Encode
Files window via the Settings button. Ensure that you have selected Nero AAC as the

Output file format.

Encoding quality:

Mode:

Mero AAC Encoder Settings

-

=

Variable Bitrate (VBR.) -
Quality:
Small file size High quality
Target file bitrate: 169 kBit/s
Quality index: 0.50
Use .m4a extension for writing files (this is global setting and will affect all files!)
Ok ] | Cancel

Nero AAC Encoder Settings
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The following setting options are available in the Nero AAC Encoder Settings window:

Drop-down menu
entry

Variable Bitrate

Drop-down menu
entry

Average Bitrate

Drop-down menu
entry

Constant Bitrate

Slider
Quality

Check box

Specifies a variable bit rate, i.e. the data flow per unit of time and
thus the quantity of the saved data adapts to the dynamics of the
audio file. The bit rate, for example, can be lowered at quieter points
in the track.

You can set the variable bit rate between 0 and 100. 0 means the
lowest, 100 the highest quality.

Specifies an average bit rate, i.e. the data flow per unit of time and
thus the quantity of the saved data adapts to the dynamics of the
audio file but the average bit rate tends to the defined value. In
principle is it a variable bit rate with a limited bit band width and thus
combining the advantages of the variable and the constant bitrate.

Specifies a constant bit rate, i.e. the data flow per unit of time and
thus the quantity of the saved data is the same over the entire audio
file.

Specifies the bit rate, i.e. the data flow per unit of time and thus the
guantity of the saved data.

If the bit rate is small, less data is transferred. The file is then small,
but quality is lower. If the bit rate is high, more data is transferred.
The file size is then large, but the quality is high. The default value of
128 is near CD quality.

Encodes the audio files in the M4A audio file format; which was

Use .m4a extension j.fined by Apple.

for writing files

4.5.6 OGG Vorbis Encoding Options

Nero Burning ROM can encode audio files in the OGG Vorbis format.

Set options in the OGG Vorbis Settings window that you can open in the Encode Files
window via the Settings button. Ensure that you have selected OGG Vorbis as the Output

file format.

The following setting options are available in the OGG Vorbis Settings window:

Check box
Constant Bit Rate

Specifies a constant bit rate, i.e. the data flow per unit of time and
thus the quantity of the saved data is the same over the entire audio
file.

If the bit rate is small, less data is transferred. The file is then small,

but quality is lower. If the bit rate is high, more data is transferred.
The file size is then large, but the quality is high. The default value of
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Check box
Variable Bit Rate

128 is near CD quality.

Specifies a variable bit rate, i.e. the data flow per unit of time and
thus the quantity of the saved data adapts to the dynamics of the
audio file. The bit rate, for example, can be lowered at quieter points
in the track.

You can set the variable bit rate between 0 and 100. 0 means the
lowest, 100 the highest quality.
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5 Video

5.1 Compiling DVD-Video
With Nero Burning ROM you can burn DVDs made up of DVD-Video files from your hard
drive. You can play your burned DVDs on almost all DVD players.

You can use Nero Burning ROM to burn a DVD Video if the DVD video title, i.e. a complete
DVD folder structure, is already available.

.] In Nero Burning ROM it is not possible to convert video files to DVD-Video, an

AVCHD video, or a BDMV-Video. Converting video files to DVD-Video, to AVCHD
video, or BDMV-Video is possible in Nero Video for example. Nero Video is
included in the full version of Nero 12. More information about Nero Video is
available on the Web site www.nero.com, and more information about video
editing is available in the separate Nero Video manual.

e

To compile a DVD-Video, proceed as follows:

1. Select the DVD entry from the drop-down menu in the New Compilation window. (In case
that the New Compilation window is not opened, it can be opened by clicking the New
button on the main screen.)

2. Choose the DVD Video compilation type from the selection list.
= The tabs with the configuration options that are valid for this compilation type are

displayed.
Mew Compilation E
' VD «| [mfo_ [150 [isbel [Dates [Msc [Bum |
Action
g™ | Determine maxmum spesd
Sl Simudation
WO Copy Tt
;ﬂ - Verify written data
Wiriting
Write speed:
Write method:
i
o Number of copes:
[ DWD-ROM (Boat)
Use multple recorders
W
DVD-ROM (UDF)
— =
R Mero Express o Qeen... l e J !0 Cancel

DVD Video Tab
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3. Set the options you require on the tabs.

4. Click the New button.

Bootable Disc

= The New Compilation window is closed and the selection screen is opened.
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« M Computo VIDED) TS B
VIED_TSFO
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VTS [0 BIFD
- 5.0 1 W0
Sy Hstrmcrk WS I WOR
& Contend Panel
A Ezcycle Bn
.
hoern 11
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Hiare Covem Dy
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VDEQ_TS
(Rl K] ¥ [
1 | | evne (g5 08 =
168 168 ] 468 568 468 58 168 e
Teotal sotu e lsic: 01 GB HL-DT-5T BO-RE GEW-H2L

DVD Video Compilation Screen

5. Select the DVD-Video files that you want to burn from the File Browser area on the right

side.

6. Drag the existing DVD folder structure of the video title (VIDEO_TS) into the Disc Content

area on the left side.

= The files are added to the compilation and displayed in the compilation screen. The
capacity bar indicates how much space is required on the disc.

= You have successfully compiled a DVD-Video and can now burn this compilation.

See also
Selection Screen —19

5.2 Compiling an AVCHD Video Disc

With Nero Burning ROM you can burn an AVCHD video disc made up of AVCHD video files

from your hard drive or camcorder. The AVCHD video disc can be burned to a DVD as
usual, or to a Blu-ray Disc. Burning to a Blu-ray Disc has the benefit that it offers more space

than a DVD.

AVCHD video on DVD is compatible to the specification of a Blu-ray Disc. However,

playback is not guaranteed on all Blu-ray players.

Nero Burning ROM
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You can use Nero Burning ROM to burn an AVCHD video disc if the complete folder
structure including premastered files is already available.

.] In Nero Burning ROM it is not possible to convert video files to DVD-Video, an

AVCHD video, or a BDMV-Video. Converting video files to DVD-Video, to AVCHD
video, or BDMV-Video is possible in Nero Video for example. Nero Video is
included in the full version of Nero 12. More information about Nero Video is
available on the Web site www.nero.com, and more information about video
editing is available in the separate Nero Video manual.

e

To compile an AVCHD video disc, proceed as follows:

1. Select the DVD or Blu-ray entry from the drop-down menu in the New Compilation
window. (In case that the New Compilation window is not opened, it can be opened by
clicking the New button on the main screen.)

2. Choose the AVCHD (TM) video compilation type from the selection list.

= The tabs with the configuration options that are valid for this compilation type are
displayed.

Mew Compilation @l

2 Buray =| Infg [lsbel [iMsc |Bum
- Automalic

&

€l

Blu-ray (UDF)

Disc name: Nera Video

Add Date... Add Coygnter...

“H

BOWIV-Video

“H

]

Blu-ray (SecurDisc)

AVCHD (TM) video - New Compilation Window

3. Enter a name for the AVCHD video disc in the Disc name input field.
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4. Click the New button.

= The New Compilation window is closed and the selection screen is opened.
It includes the specific AVCHD folder structure.

Bootable Disc
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AVCHD video - Selection Screen

5. Select the movie that you want to burn from the File Browser area on the right side.

6. Drag the existing folder structure including premastered files into the Disc Content area on

the left side.

= The files are added to the compilation and are displayed in the compilation screen. The

capacity bar indicates how much space is required on the disc.
= You have successfully compiled an AVCHD video disc and can now burn this

compilation.

Files and Folders

The AVCHD video contains different folders. Only certain files are allowed in an
individual folder. If you only have individual files, you must allocate the right files

to the specific folder:

\BDMWindex.bdmv
\BDMV\MovieObject.bdmv
\BDMV\PLAYLIST\*.mpls
\BDMV\CLIPINF\*.clpi
\BDMV\STREAM\*.m2ts
\BDMV\AUXDATA\sound.bdmv
\BDMWV\AUXDATA\*.otf

\BDMV\ABDJO\*.bdjo (these files are optional; however, the folder must be

available)

Also, the folders \BDMV\META, \BDMV\JAR and \CERTIFICATE must be

Nero Burning ROM
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available but may remain empty.

If the folder \BDMV\BACKUP is available it contains a copy of the files
index.bdmv, MovieObjects.bdmv and the folders PLAYLIST, CLIPINF and BDJO.

Additionally, an AVCHD video may contain the folder AVCHDTN. This folder must
not be available if it is empty. If it is available, it has to contain the following files:

\AVCHDTN\thumbnail.tidx
\AVCHDTN\thumbnail.tdt2

5.3 Compiling a BDMV-Video Disc

With Nero Burning ROM you can burn a BDMV-Video disc made up of BDMV (= Blu-ray
Movie) files from your hard drive. You can play your burned BDMV-Video on almost all Blu-
ray players.

You can use Nero Burning ROM to burn a BDMV-Video if the complete BDMV folder
structure including premastered files is already available.

l In Nero Burning ROM it is not possible to convert video files to DVD-Video, an

AVCHD video, or a BDMV-Video. Converting video files to DVD-Video, to AVCHD
video, or BDMV-Video is possible in Nero Video for example. Nero Video is
included in the full version of Nero 12. More information about Nero Video is
available on the Web site www.nero.com, and more information about video
editing is available in the separate Nero Video manual.

To compile a BDMV-Video disc, proceed as follows:

1. Select the Blu-ray entry from the drop-down menu in the New Compilation window. (In
case that the New Compilation window is not opened, it can be opened by clicking the
New button on the main screen.)

2. Choose the BDMV-Video compilation type from the selection list.

= The tabs with the configuration options that are valid for this compilation type are
displayed.
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Mew Compilation

e

€l

Blu-ray (150}

&«

Blu-ray Disc Copy

€L

Blu-ray (UDF)

“

| [info [Lobel [Misc [Bum |

Action

| Determine maximum speed

o write

size disc (Mo furthes
| denfy wntten data

Writing
Vipte speed: lm
Wnte method: Crsc/Session at-onoe
tumber of copies: 1

Lise muitiple recorders

f Mero Express

o] [O=

| © e

3. Enter a name for the BDMV-Video disc in the Disc name input field

4. Click the New button.
= The New Compilation window is closed and the selection screen is opened.

It includes the specific and predefined BDMV folder structure.
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BD Video Selection Screen

5. Select the movie that you want to burn from the File Browser area on the right side.

6. Drag the existing BDMV folder structure including premastered files into the Disc Content

area on the left side.

= The files are added to the compilation and are displayed in the compilation screen. The
capacity bar indicates how much space is required on the disc.

= You have successfully compiled a BDMV-Video disc and can now burn this
compilation.

Files and Folders

The BDMV-Video contains different folders. Only certain files are allowed in an
individual folder. If you only have individual files, you must allocate the right files
to the specific folder:

\BDMW\index.bdmv

\BDMV\MovieObject.bdmv

\BDMWV\PLAYLIST\*.mpls

\BDMV\CLIPINF\*.clpi

\BDMW\STREAM\*.m2ts

\BDMV\AUXDATA\sound.bdmv

\BDMV\AUXDATA\*.otf

\BDMV\BDJO\*.bdjo (these files are optional; however, the folder must be
available)

Also, the folders \BDMV\META, \BDMWJAR and \CERTIFICATE must be
available but may remain empty.

If the folder \BDMV\BACKUP is available, it contains a copy of the files
index.bdmv, MovieObjects.bdmv and the folders PLAYLIST, CLIPINF and BDJO.

Nero Burning ROM
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6 Bootable Disc

With Nero Burning ROM you can create a bootable disc with which the computer can be
started without having to access the hard drive. For this reason a bootable disc is often used
as an "emergency disc" to start the computer if it is not possible to access the hard drive.
Bootable discs are created in accordance with the "El Torito" standard, an extension to the
ISO-9660 standard, which defines the structure of data discs. The disc contains a boot
image and an ISO part. The boot image contains all files that are required to load the
operating system and to start the computer. The ISO part can contain any humber of data
files that you can back up using this method.

6.1 Requirements for Booting From a Disc

To ensure that a computer can boot from disc, the start sequence must be set in the BIOS of
the computer in such a way that the drive is addressed first as the boot drive (start sequence
CD-ROM, C, A for instance). In the case of an SCSI CD-ROM drive, this drive must be
connected to an SCSI adapter with a separate BIOS in which settings can be modified
accordingly. (This will only work if there are no IDE hard drives present, as these come
before the SCSI adapter in the boot sequence.)

When booting from a disc, you can only start an operating system that does not write to the
medium, such as "MS DOS" or "Linux". During booting, Microsoft Windows 2000 and
Microsoft Windows XP write to the medium from which they are being booted. This is not
possible with a disc and so the process is canceled and the PC cannot be started.

6.2 Bootable Disc Template

For Nero Burning ROM, the template for creating a bootable disc can be either a logical drive
or a drive image file which contains the contents of a drive as a file sector for sector. If the
template for the bootable disc is a logical drive, the bootable disc will emulate this when the
system is booting. There are three emulation types:

m Floppy emulation: This requires a bootable floppy disc for creating the bootable disc. At
startup the bootable disc emulates a floppy disk. In the process, the drive letters
increment, so that Drive A: corresponds to the bootable disc. The volume of the start
data is limited by the capacity of the floppy disk (e.g. 1 MB).

m Hard drive emulation: A bootable hard drive is required to create the bootable disc. At
startup the disc emulates Drive C. All drive letters from Drive C increment by one. The
volume of the start data is limited by the capacity of the CD (e.g. 700 MB) or DVD (e.g.
8.5 GB). If, for instance, you have a 200 GB hard drive with only one (200 GB) partition,
you cannot create a bootable disc from it without repartitioning your hard drive
accordingly beforehand.

® No emulation: In this process the drive names are not changed. This type is used for

bootable installation CDs. This setting is intended for users who do not require a floppy
or hard drive emulation and who want to install their own device driver.
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6.3 Creating and Burning a Bootable Disc

To create a bootable disc, proceed as follows:

1. Click the New button in the main Nero Burning ROM screen.

= The New Compilation window is opened.

2. Select the desired disc format from the drop-down menu.

3. Select the desired Boot compilation type.
= The tabs for the bootable disc are displayed; the Boot tab is in front.

Bootable Disc

[ Mew Compilation 1
% o ~| linfo  Boot  Autorun |150 | Lebel |Dates |Misc | Bum
.|| Source of boot image data

.-._E Bootabie logical drive (must fit on the DVD!

Mo drives with Sze < S00ME found|
DVD-Video
@ Image fle
C: 'P\’wam FiasNaraiNera lZ'ﬂE"ﬁ &.ﬂ'nﬂg ROM 'Dﬁsﬂmhmage]]‘d ! E'GI’I'SE...
B Boot locake; |Englsh (Urited States) -
AVCHD{TM] vides Adiaaced

Enable expert settings (for advanced users only!)

a ,

DVD-ROM (Boot)

W

DVD-ROM [I510)

| [ oree

Boot configuration

yrem—

4. If the template data for the bootable disc should originate from a logical drive:
1. Select the Bootable logical drive option button in the Source of boot image data area.

2. Select the entry you want from the drop-down menu.

If the logical drive you want does not appear in the drop-down menu, the reason
for this is that the drive is bigger than the space available on the disc. Please note
that for operating systems such as Microsoft® Windows® 2000 you need to have
administrator rights in order to be able to access drives directly, which you will
need to do if you are to create bootable discs.

s
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5. If the template data for the bootable disc should originate from an image file:
1. Select the Image file option button in the Source of boot image data area.
2. Click the Browse button and select the desired image file.

3. Select the Enable expert settings check box and select the emulation type for the
image file from the Kind of emulation drop-down menu if appropriate.

-+, DosBootimage

’ ? Nero Burning ROM makes the boot image file DosBootimage.ima available. The
path to the image file is entered in the Image file field by default. You can also
select the language that should appear while the system is booting and select the
correct keyboard layout from the Boot locale drop-down menu.

DosBootimage is an image of the Caldera DOS boot floppy disk and emulates a
floppy disk. The image contains drivers for reading from disc drives and supports
FAT32 (read/write) as well as NTFS (read only). If you choose DosBootimage for
the bootable disc, the expert settings are already predefined.

"a- If you choose an ISOLINUX boot image file, Nero Burning ROM sets the expert
’ ? settings automatically correct for ISOLINUX bootable disc.

6. Select any other options required on the tabs.

/. Click the New button.
= The selection screen is displayed.

8. Select the files/folders that should be written to the ISO part of the bootable disc and drag
them into the Disc Content area.

= The files/folders are displayed in the Disc Content area and the capacity bar
indicates how much storage space is required on the disc. You have now created
the bootable disc and can start the burn process.
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Loading Image File

You can use Nero Burning ROM to burn a disc from a disc image that you have previously

saved on the hard drive.

To load a saved image file, proceed as follows:

1. Select a recorder from the drop-down menu.

2. Click the L& button in the main screen.

= The Open window is opened.

& Nero Buming ROM

@ Open

- |‘f‘ |Search

Favorite Links

B Desktop

%5l Recent Places
8 Computer

E Documents

E| Pictures

E’ Music

% Recently Changed
E Searches

Ju Public

~

File name:

[
a

G@vm » 09, English Doctrans » Documents »
=

Date modified

NeroVision
File Folder

Image
CD Image
631 MB

Type

3. Select the desired image file and click the Open button.

= The Burn Compilation window is opened.

Nero Burning ROM

= ] Image Recorder r

Open window
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4. Set the desired burn options.

Burn Compilation window

5. If technically possible, you can change the disc type in the drop-down menu.

6. Click the Burn button.

= The burn process is started. A progress bar indicates the progress being made by the
burn process. When the burn process is complete the disc is ejected.
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Burning process

= The burning process is complete. You can now remove the burned disc from the
recorder.
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8 LightScribe

Using Nero Burning ROM and a LightScribe recorder you can create or load labels that you

can burn onto the label side of CDs/DVDs in the LightScribe recorder. The function is
available as a separate Print LightScribe Label option in the start screen or can be
integrated as an intermediate step into the creation and burn process of a project.

'] This function is only available in recorders that support LightScribe technology.
E

8.1 Printing LightScribe Label

The process for printing the label is integrated into the burn process. First, the compilation is
burned. You then flip the disc over, and the label is being burned.

It is possible to burn the label several times to the same LightScribe disc. The printed labels
will be aligned. This darkens the label und often improves the quality. It is also possible to
extend the label with new elements in an additional burn process.

The following requirement must be fulfilled:

A A LightScribe recorder is selected.
To print a label within your compilation, proceed as follows:

1. Select the desired compilation type in the New Compilation window.
(In the case that the New Compilation window is not opened, it can be opened by clicking
the New button on the main screen.).

2. Click the Misc tab.

Mew Compilation @
4 DVD »| | Info | Muitisession | Nero DiscSpen | Autorun [ 150 | Lebel | Dates [[M5c__| Bum
Caching
E ¥ Cache fies from floppy, optical- and network drives

Cache fies smaller than
AVCHD{TM] video

LightScribe

U

e Print label
DVD-ROM [Baot)

: ""!J E AV files

Search and replace FourCC codes in =.avi fles while buming. The source files will nat
be changed,

't

DVD-ROM [UDF/IS0)

_F*: Mero Express _;1- Qpen..., | | Dl EQ Concel
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3. Select the Print label check box in the LightScribe area.

4. Click the Create button.

= The CD Label Editor window is opened.

&!E"ccumenl CD Label Editor o= || & |EE
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CD Label Editor

5. Create your label or open an existing one that you have created with Nero CoverDesigner.

-1+ The interface in the CD Label Editor window and the procedure for creating

= ;’ labels work on the same principle as Nero CoverDesigner. Please see the Nero
CoverDesigner user manual for full instructions on how to make professional
looking covers and labels.

6. Set further options that you require.
7. Click the New button.
= The New Compilation window is closed and the selection screen is displayed.

8. Select the files to burn (see Compiling Data Disc— 22).

9. Insert a blank LightScribe CD with the data side facing down.
10. Click the Burn Now button.
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= The burn process starts and the compilation is burned. A progress bar indicates the
progress being made by the burn process. When the burn process is complete the disc
is ejected. A window is opened with the message "Please insert a LightScribe disc
into the drive with the label side facing down".

11. Insert the LightScribe disc into the recorder with the label side facing down and click OK.

= The LightScribe Print Properties window is opened and the print process starts. In the
LightScribe Print Properties window a progress bar indicates the progress being
made. When the print process has finished, a window is opened with the message
"Burn process completed successfully".

12. Click the OK button.

= The disc is ejected. You have burned the compilation and printed a LightScribe
label.

See also
2 LightScribe Settings —126

8.2 CD Label Editor Window

In the CD Label Editor window, you can create or load a label. The window is opened when
you click the Create button in the LightScribe area on the Misc tab for the current
compilation.

-+, The interface in the CD Label Editor window works on the same principle as
- ? Nero CoverDesigner. Basically, it is irrelevant whether you print the label on
paper or directly onto an appropriate disc. Please see the separate Nero

CoverDesigner user manual for full instructions on how to make professional
looking covers and labels.
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Document - CD Label Editor Window

The following configuration options are available:

Inner radius
Outer Radius

Width

Label templates

New

Open

Save As

OK

Preview

Cancel

Defines the distance between the label and the inner edge.
Defines the distance between the label and the outer edge.
Defines the width of the print area.

Contains a selection of different templates for designing the label.
You can continue to edit and customize a selected template.

Generates a new label document.

Opens an existing label which was created using Nero
CoverDesigner.

Saves the label you have created.
Adds the label you created to the compilation and closes the window.

Opens the Print Preview window that shows how the label should
appear on the LightScribe disc.

Cancels the procedure and closes the window.
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9 Labelflash

If you have a Labelflash recorder, you can print a label on the label and/or data side of the

Labelflash DVD. A Labelflash DVD has a special layer between the top and bottom layers;
this layer can be heated by the laser in the recorder so that images and text can be printed
on the DVD.

-+ The interface in the Burn Label screen works on the same principle as Nero
= ? CoverDesigner. Basically, it is irrelevant whether you print the label on paper or
directly onto an appropriate disc.

Please see the separate Nero CoverDesigner user manual for full instructions on
how to make professional looking covers and labels.

" This feature is only available in recorders that support Labelflash technology.

Y

9.1 Burn Label Window

In the Burn Label window you can create or load a label and write it on a Labelflash DVD.
Information on the selected printing quality and rotation speed is displayed on the right-hand
side of the screen. Under Disc type you can see whether the blank disc has been inserted
with the label or data side. Either the Labelflash or the DiscT@2 logo is displayed in the
Burn Label window depending on which side is inserted.

Y Bum Label
File Edit Action
v xu9e WAL -
i B il lLabelflash
\ e N B 24 B L
OE 7 e 8| F & | Q .
Optiarc DVD RW AD-71735
= § oW £ Q'.I_'_\:l 0,00 I;:I !Oll
1 Brinting area:
e |1
adl|g: Inner radius: 25 (=-mm
—1%= =
8 H Width: 33 =imm
E
-5 Printing Quality Change |
& o Best qualty
#ey = Rotation spead
E 7875 rpm
= Disc bype: P——
Ma dee in drive
= Expected wmnting tms
2-
e 2220 mn
= Label templates:
2- [Free styie |
| Cancel
1]
|

Burn Label Window
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The following configuration options are available in the Burn Label window:

Input field

) Defines the distance between the label and the inner edge.
Inner Radius

Input field , . .
) Defines the width of the print area.
Width

Button Opens the Labelflash Print Properties window.

Change This is where you can change the printing quality and the contrast

9 level and display the changes made directly in the print preview.

Button Opens the Print Preview window that shows how the label should

Preview appear on the Labelflash disc.
Selection list Contains a selection of different templates for designing the label.

Label templates  You can continue to edit and customize a selected template.

Button
Starts the burn process.
Burn

Button _
Cancels the procedure and closes the window.
Cancel

If you are creating a DiscT@2, Nero Burning ROM displays only the available
print area for creating the label by default, i.e. the area on the data side of your
DVD that is not already taken up by data. You cannot increase the radius of the
print area.

<

9.2 Printing Labelflash Labels and DiskT@2

Basically, it is irrelevant whether you print on the label or the data side when creating labels.
The label is actually printed outside the normal burn process.

You can print on the label side of the DVD at any time.

’ ? We recommend that you print on the data side first when you have burned the
compilation. It is not possible to burn data on a printed data side. When you insert
a DVD on which data has already been burned, Nero Burning ROM automatically
identifies the space that is still available on the data side and on which you can
print.

To print a Labelflash label on the label side or a DiskT@2 on the data side of your DVD,

proceed as follows:

1. If you want to print a Labelflash label on the label side, insert a blank Labelflash disc into the
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recorder with the label side facing down.
= The Burn Label window is opened with the Labelflash logo.
2. If you want to print a DiskT@2 on the data side, insert a blank Labelflash disc with the data
side facing down in the recorder.
= The Burn Label window is opened with the DiskT@2 logo.

3. Create a label according to your requirements or open a label that you have already created
with Nero CoverDesigner.

The interface in the Burn Label window and creation of a label work on the same
principle as Nero CoverDesigner. See the separate Nero CoverDesigner manual
for full instructions on how to create professional looking covers and labels.

4. If you want to change the area in which the label is printed, change the print area
accordingly using the input fields Inner Radius and Width.

5. If you want to view or change the print properties:
1. Click the Change button.
= The Labelflash Print Properties window is opened.

2. If you want to change the printing quality, select a quality level from the Print quality
profile drop-down menu.

3. If you select the User defined entry from the Print quality profile drop-down menu, you
can change the contrast level and the rotation speed.

4. Click the OK button.
= The Labelflash Print Properties window is closed and the changes are accepted.
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A LabelFlash(Th) Print Properties

55
Prirt Device Information
_NEC D"v"D_H","'..' ND-45714 Print EILIE||HI}' pl‘D‘filE
Fimware Version: 1-01 Best quality -

Contrast level (1-100)
Select the default side that you would like to

prirt your label on:

cTE2TM Rotation speed

T

[ Frint Prewview LabE laghm

Eject disc after printing has finished

Labelflash Print Properties
6. Click the Burn button.

= The labeling procedure starts and the Labelflash - printing or DiscT@2 - printing
window is opened. The window shows the estimated printing time and the print progress.
When printing is complete, a message window is opened informing about the successful

print process.
/. Click the OK button.
= The message window is closed and the disc ejected.
= You have successfully printed a label.
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10 Burn Compilation

10.1 Choose Recorder Window

In the Choose Recorder window you can select a recorder for burning. You can open the
window via the button which is on the right side of the recorder drop-down menu. The
window shows useful information about the recorder (e.g. supported disc types). In the
advanced area you can set expert options. The available options depend on the chosen

recorder.
Choose Recorder =
Device Adapter Stalug
& Image Recorder Yirlual Device 0K,
= E:- HLDT-5T DVDRAM GH2OMS15  IDE 0K
& F: HL-DT-5T BD-RE GGW-H20L Senal ATA Ok
= G HLDT-5T DvVD-RAM GSA-HSSL  USE 20 0k,

Dizc types: CO-RAW, DVD RARW, DVD DL, DVD-RAM, BD-R/RE. BD DL

b aarmumn CD speed: 40w [6.000 KB./g) Dizc-at-once: CugSheet, D096
Fitriwaie f@vizion: YLO3 CD TEXT: Siippoited
Dwerburre Supported Recorder buffer: 2048 KB

Buiffer undemun pratechon Supported

. Optons <<, et [ [ Goncel |

| Buffer undesmun protection J DWD hagh compatibiliy mode (at keast 1GE will be
varitten|

Book Type settings: | BD defect management [for blank dizcs only)

|AL.I|:|matin 'J

Choose Recorder

The following setting options are available in the advanced area:

Check box Provides buffer underrun protection.
Buffer underrun . T o _
protection This feature is particularly useful for burning CDs.

Writes an extended lead-out of 515 MB on the second layer of a
Check box double-layer multisession DVD when this area contains less data.
Write extended | Doing so improves the read compatibility.
lead-out on double- | This feature is particularly useful for burning a data multisession

layer discs DVD on a double-layer disc. It is not needed when the DVD is going
to be finalized.
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Check box

DVD high
compatibility mode

Check box

BD defect
management

Drop-down menu

Burns the DVD up to a radius of at least 1.2 inch (~ 30 mm, approx.
1 GB), even when the compilation contains less data. In doing so the
DVD is forced to meet the DVD-Video specification which reduces
the possibility of read errors.

This feature is particularly useful for burning DVD-Videos.

Burns the Blu-ray Disc in defect management mode. In doing so the
burner allocates part of the disc so that it is able to burn the data that
has been damaged in a write error once again. BD defect
management reduces the write speed but increases data security.

This feature is particularly useful for burning data Blu-ray Discs or for
burning backups to Blu-ray Discs.

Defines the book type setting for a DVD.

Book Type Settings Thjs feature is particularly useful for burning to a blank DVD.

2

Four book type settings are available:
Automatic: Automatically selects the most suitable book type for this DVD.

DVD-ROM: Sets the book type to DVD-ROM. Select this setting if the DVD is to
be played on several DVD players or your DVD player has difficulties with self-
burned DVDs or of the DVD-, DVD+ or DVD-RW specification.

Physical disc type: Selects the book type which is specified on the DVD.
Current recorder setting: Leaves the book type setting to the recorder.
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10.2 Burn Settings

The Burn tab on the Burn Compilation window provides options for the burn process.
Which options are enabled, depends on the chosen compilation.

[info_ | Multisession [ 150 |UDF | Label | Dates [ Misc | Bumn |

Action
|:| Determine maximum speed
[T simulation
Wirite
Finalize disc (Mo further writing possible!)
[] verify written data

SecurDisc Surface Scan

Writing
Write speed: [Maximum "]
Write method: [DiscfSession—at—once "]
Mumber of copies: 1

Buffer underrun protection

[] Use multiple recorders

Burn Tab

The following check boxes are available in the Action area:

Checks how fast the compiled data can be accessed and
reduces the selected write speed if necessary. This prevents a

Check bOX_ . buffer underrun.
Determine maximum Recorders with a feature to prevent buffer underruns do not
speed require a speed test.
Not available when saving with Nero Image Recorder.
Simulates burning. In the process the simulation performs all
Check box steps that are also carried out during burning with the
Simulation exception of setting the laser beam. A test determines whether

there is a constant flow of data.
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Check box
Write

Check box
Finalize disc

Check box
SecurDisc Surface Scan

Enables the Burn button.

Closes the disc so that you cannot write to this disc anymore.
Depending on the disc format, finalizing may be necessary.

Nero Burning ROM automatically selects this check box for the
relevant disc formats.

Checks the quality of the disc surface after the burn process.
You can use this option particularly when burning backups or
discs that have to be archived to ensure that the disc surface
does not have any issues and that burning went well.

This check box is only active if Verify written data is selected.

The following configuration options are available in the Writing area:

Drop-down menu
Write speed

Drop-down menu
Write method

Input field
Number of copies

Check box

Buffer underrun
protection

Check box
Using multiple recorders

Nero Burning ROM

Selects the write speed at which the disc is burned.

Selects the method used to burn the disc. The following
methods are available.

Track-at-once: Burns each audio file (track) separately onto
the disc, i.e. the laser is turned off and turned on again after
each audio file.

Disc/Session-at-once: Burns each session of a multisession
disc separately onto the disc.

Disc-at-once/96: Burns the entire disc in one go without
having to turn off the laser between individual audio files. The
disc is finalized after burning.

Defines the number of discs that are to be burned. The default
is set to one disc.

Provides buffer underrun protection.

This check box is only available for a CD and if the selected
burner supports a method which offers buffer underrun
protection.

Burns the compilation to multiple disc. When you click the
Burn button, a window is opened in which you can select the
desired recorders. The burn process is then carried out
simultaneously on the selected recorders.
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The speed test and simulation are not required for recorders that have a function

? for protecting against buffer underruns. Current recorders mostly have such a
feature.
’ - Audio CDs should always be burned using the disc-at-once method. This entry is
¥~ selected by default.

10.3 Starting the Burn Process

“a- Many CD players cannot read rewritable CDs (CD-RW). You should therefore use
’ ? normal CD-ROMs for burning Audio CDs.

To start the burn process, proceed as follows:
1. Choose a recorder from the drop-down menu in the main screen.
2. Insert an appropriate blank disc.

3. If technically possible you can change the disc type in the drop-down menu.

-+, You can select an appropriate disc format without loss of information at any time
“®:  in the main screen. Note that this has to be technically possible - for example you
N are obliged to burn an Audio CD to a CD. But it is possible to start with a data CD
and change later to a data DVD, for example. The possibility to change the disc
type is useful when starting a compilation without knowing how much space is
required by the files.

4. If you want to check or select the options regarding this compilation type:

1. Click the Burn button in the main screen.

= The Burn Compilation window is opened; the Burn tab is in front.
2. Check or select the options on the individual tabs.
3. Click the Burn button.

5. If you want to start directly, click the Burn Now button in the lower main screen.

= |f the Select multiple recorders check box was selected, the Select Recorder window
is opened.

6. Select recorders here and click the OK button.

= The burn process is started. On the screen a progress bar indicates the progress being
made by the burn process. You have some options during the burn process.
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Burning process

. If you want to shut down the PC after burning (as long as this is technically feasible), select

the Automatically shut down the PC when done check box.

. If you want to check the written data after burning, select the Verify written data check box.

. If you want to check the disc surface after burning, select the SecurDisc Surface Scan

check box.

= |f the SecurDisc Surface Scan check box is selected, the SecurDisc Surface Scan

Results window is opened.

Nero Burning ROM
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Nero Burning ROM - SecurDisc Surface Scan Results ot e

Desc

Surface Scan

H Good: 25.8%  Progress: 25,8%

[l pamaged: 0.0% Position: 368639

Il Bad: 0.0% Speed: 5.5x
File Position Length Quabty e
\NERO_VIDEQ'WERO_11\SUITE 11\AFFLIC. ., 304667 45 Good
\MERO_VIDEQWERO_11\SUITE11\APPLIC.., 304712 46 Good
\NERO_VIDEQOWERO_11\SUTTE11\APPLIC... 304758 36 Good
WERO_VIDEQOWERO_11\SUTTE 11\APPLIC... 304794 49 Good

- |

|| Close when burn process is finished i S |

Surface Scan window
= Nero Burning ROM starts with the surface scan. The results are displayed in realtime.
= When the burn process has finished, a message window is opened.

10. If you want to display the extended area with the event log, click the Details button.

11. If you want to start another burn process with the same compilation, click the Burn Again
button.

12. Click the OK button.

= The burning process is complete. You can now remove the burned disc from the
recorder.

10.3.1 SecurDisc Surface Scan Results

On the SecurDisc Surface Scan Results window the results of the surface scan are
displayed in realtime. The scan test is carried out after the burn process when the
SecurDisc Surface Scan check box is selected, either on the Burn tab or in the Burning
process screen.

The surface scan lets you check the quality of the disc with respect to completeness of the
sectors. The test results are displayed both in a graph and in detail in the display panel
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below the graph.

Nero Burning ROM - SecurDisc Surface Scan Results o]

Dese

Surface Scan

[ Good: 25.8%  Progress: 25.8%

[]oamaged: 0.0% Postion: 368639

[l Bad: 0.0% Speed: 5.5x
File Position Length Quakty |
\NERO_VIDEQWERO_11\SUITE 11APPLIC. ., 304667 45 Good
\MERO_VIDEQWERO_11\SUITE 11\APPLIC. ., 304712 4 Good
WNERO_VIDEOWERO_11\SUTTE11VAPPLIC. .. 304758 3% Good
\NERO_VIDEQWERQ_11\SUITE11\APPLIC. . 304794 49 Good I

[7] Close when burn process is finished I |
Hide

SecurDisc Surface Scan

The graph shows all sectors on the disc in one chart, with each sector being plotted with a

small square. Each square, i.e. each sector, is displayed in a different color depending on its
status. The Surface Scan area shows the respective percentage of sectors in the following
three categories: Good, Damaged, and Bad in real time while the test is running. The
following colors, i.e. status indicators, are available:

Green Readable sectors with no errors.
vellow Damaged sectors that can still be read using the recorder's internal
error correction feature.
Red Damaged sectors that cannot be corrected and are consequently

unreadable.

The following display panels are also available in the Surface Scan area while the test is
running:
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Shows the progress of the test, i.e. the percentage of the disc

Progress
9 already scanned.
- Indicates continuously the current position of the read head on the
Position .
disc.
Speed Shows the scanning speed.

The following information is available in the columns in the display panel:

File Lists the names of the files on the disc in the drive.
Position Shows the exact position of the file on the disc.
Length Shows the length of the individual files.

Specifies the quality of the files. This score is calculated from the

ualit
Q y number of errors found.

10.4 Burning With Image Recorder — Creating an Image File

With Nero Burning ROM and the Image Recorder you can create disc images from every
compilation. The NRG image file format can always be selected whereas the ISO image file
format can only be selected from certain compilation types. Nero Burning ROM only enables
the possible image file formats.

The NRG image file format was developed by Nero. In contrast to ISO, NRG can be created
from every disc and compilation type. This means that even Audio CDs or multisession discs
can be saved as an NRG image file.

To create an image file, proceed as follows:
1. Click the New button.

2. Create a new compilation of your choice.

.1+ Using Nero Burning ROM you can create image files for disc types that the
“®:  installed recorder cannot burn. You can enable this function via the File >
N Options > Expert Features menu, Enable all Nero supported disc types for
the Image Recorder check box. The drop-down menu in the Compilation
window then makes available all supported disc types.

3. Select the files that you want to burn.

4. If you have installed multiple recorders, select Nero Image Recorder from the drop-down
menu.

5. Click the Burn button.
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= The Burn Compilation window is opened; the Burn tab is in front.
6. Click the Burn button.
= The Save Image File window is opened.

7. Specify a file name and a storage location for the image file and click the Save button.

= The image file is created and saved in the selected storage location. On the screen, a

progress bar indicates the progress made while the file is being created. Once the
creation process is over, a message window is opened.

8. Click the OK button.

= The message window is closed and you have successfully created the image file.

See also
Expert Features —124
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11 Copying a Disc

11.1 Methods of Copying

Nero Burning ROM can be used for copying discs. There are two methods for this:

m On-the-fly
m Copy Over Image
Each method has advantages and disadvantages which will depend on your requirements.

11.1.1On-the-fly Copying

When using the on-the-fly method, insert the original disc into a drive and a recordable disc
into the drive. The original disc in the drive is copied immediately without any time delay to

the blank disc in the recorder. The on-the-fly method allows you to copy discs very quickly,

and does not require any additional space on the disc.

In order to be able to use the on-the-fly method, you will need at least two drives: one for
reading the disc and a disc burner for writing. The following requirements apply to the read
drive and disc burner:

m The disc burner must feature buffer underrun protection, or the drive must be capable of

delivering the data sufficiently quickly. The read speed should be at least twice as fast as
the write speed.

m The read drive must be capable of delivering information on the number and type of
sessions, otherwise Nero Burning ROM may not be able to produce an exact copy.

If you want to copy Audio CDs, we recommend the copy image method because the quality
of the read audio files can suffer depending on the drive.

11.1.2Copy Over Image

With the copy over image method, an image of the original disc is saved to a file first. The
image file is then burned to a blank disc. Copying using copy over image takes longer, but it
often produces better results.

You must have sufficient storage space to use the copy over image method.
The copy over image method is particularly suitable in the following situations:

m Only one drive is available.
® You would like to make several copies of the same disc.

®m You think it likely that read errors may have occurred on the source CD (for example
because it is scratched).

®m You attach importance to the best possible reproduction (particularly in relation to index
positions and the quality of Audio CDs).
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11.2 Copying Disc

With Nero Burning ROM you can copy a disc. That means you make an exact copy of a
source disc and burn it to a target disc. If your source disc is an Audio CD, for instance, your
copy will be an Audio CD as well. Depending on your installed burner, you can copy CDs,
DVDs or Blu-ray Discs. The target disc must be the same disc type as the source disc - you

can copy a DVD only to a DVD, for example. In any case, Nero Burning ROM will give you a
message when the disc type do not fit.

1Y

If you are not in possession of the copyright for the relevant disc and do not have
authorization from the owner of the copyright, unauthorized copying of discs
violates national and international legislation.

st
4

Some discs are copy-protected and cannot be copied. If you are not sure whether
your disc can be copied, activate simulation before commencing the actual

physical burn process.

To copy a disc, proceed as follows:

1. Click the Copy button in the main screen.

= The New Compilation window is opened.

Mew Compilation

Pa

Action

<

| Determine maximum speed

| Srmdation

€D Copy

] write
SiEe QEC (MO P i

| Yenfy written data

Writing
Wite speed:
Write method:
tumber of copies:

| Buffer underrun protection

o | Lise muitinle recorders

~ | | 1mage | Capy Options | Read Options E"'”".-

['.‘f Copy

| (O are

Copy Disc window

2. Select the disc format (CD, DVD, Blu-ray Disc) you want from the drop-down menu.

Nero Burning ROM
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3. Choose the type of disc to be copied (e.g. Audio CD, Karaoke CD, DVD-Video, Data Blu-ray
Disc) from the Profile selection drop-down menu on the Read Options tab.

( Mew Compilation 1
|« ovo =| | image | Copy Optons | [Read Optiors || gum
- || Profile
: I.J__. & Brofie selectan:
DVD-ROM (UDF) Do
2 Error correction
e 8 Reading vith grror correction (dow and safe)

Resad retry count:

East reading without errar correction {fast and unsafe)

_ﬁ Handling of non-correctable read errors

J T
DVD-Video Ignone read ermors

AVCHD{TM] video

{0 Cancel

:.;:i_l‘!cmEmf:ss ] -.,"i_m.;]nfn j I"‘- Cony

Read Options tab
= The read options are optimally set for the particular type of disc.

4. If you want to copy discs using the On-the-fly method:

1. Select the On the fly check box on the Copy Options tab.
2. Select the drive that contains the source disc from the Drive drop-down menu.

3. Insert the source disc into the selected drive.
4. Insert a blank disc into another drive.
5. If you want to copy discs using the Copy Over Image method:

1. Clear the On the fly check box on the Copy Options tab.
2. Select the drive that contains the source disc from the Drive drop-down menu.

3. Insert the source disc into the selected drive.
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Mew Compgilation @
4 WD = | | Image | Copy Optons | Read Options | Bumn
- General
I.] =
DVD-ROM (UDF)
E Source
‘_ _.. Drjve:
d= F: HL-OT-5T BO-RE GGAW-H2OL -
Read spead:
DVD-Video
AVCHD{TM] video
P teroE | [6f oscino |5 ¢ |'0m
; o Express 4 |8 ] n ] e ! A -

Copy Options tab

6. Click the Copy button.

= |f you are copying via the drive, the copy process starts. If you are using Nero Image
Recorder, the Save Image File message window is opened.

/. Enter a name for your image file in the File Name text box.

8. Select the relevant storage location in the Save to directory tree and click the Save button.

= The copy and/or save process starts. You can follow the process status in the status bar.
If you are using a single drive for copying, you will be prompted to remove the source
disc and to insert a suitable blank disc after the image file has been written.

9. Click the Next button.
= You have successfully copied a disc.

11.3 Copy Settings
In the New Compilation window, define the options for copying at the beginning of the copy
procedure. You can use the Copy button in the main screen to open the window. The New
Compilation window consists of a drop-down menu, various buttons, and tabs.
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fction
EDeL:fmnz maximum spesd
| Srwdation

o write

Finalze disc (No further weiting passhile!)

| denfy wntten data

Wiriting
Vigte speed: | Mansmem -
virite method: |psc/session-at-once -
tumber of copies: 1

7| Buffer underrun protecton

+ | Lise muitinle recorders

(oo Epress | o pscnfo | I;'-,," Copy ‘ |Q Cancel

Copy settings

Only those disc types supported by the recorder are displayed in the drop-down menu. If the
recorder can only burn CDs, the drop-down menu is grayed out.

.+ Using Nero Burning ROM you can create image files for disc types that the
‘@ installed recorder cannot burn. You can enable this function via the File >
F Options > Expert Features menu, Enable all Nero supported disc types for
the Image Recorder check box. The drop-down menu in the Compilation
window then makes available all supported disc types.

The following configuration options are available:

Button Displays information on the disc inserted, such as contents (if any) or
Disc Info available capacity.
Button
Starts the copy process.
Copy
Button I .
Closes the New Compilation window.
Cancel
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The following tabs are available:

Gives the path to the temporary image file and provides information
on the speed of the hard drive.

Image
Copy Options Contains options for configuring copying.
Read Options Contains options for configuring reading of the original disc.

Copy Contains options for configuring the burn process.

11.3.1Image Settings

The Image tab provides the two areas Image file and Hard drive speed info. The Image
file area is only enabled if the On-the-fly check box is cleared on the Copy Options tab.

The Image tab provides the following configuration options in the Image File area.

Input field Displays the path of the temporary image file.
Path

Check box . . .

) . Deletes the temporary image file when the copy process is
Delete image file after . .

X finished.

disc copy

Button Opens the Save As window where you can specify a file name

Browse and a directory where the temporary image file should be stored.

The following configuration options are available in the Image tab in the Hard drive speed

info area:
Drive List Lists the available hard drives with their free space..
Button Tests how far the available drives can be accessed and adds the
Test Speeds speed found to the list.
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11.3.2Copy Options

Mew Compilation ||
VD = | |image |{Copy Optans || Read Options | Bum
- General
‘ |'] On the |
DVD-ROM (UDF)
E Source
"‘_ _; Drive:
& F:HL-OT-5T BDRE GGW-H2IL -
Read spead:
DVD-Video
AVCHD{TM] video
=] = . [
Foworoe [ [loere | [§ o | © e
Copy Options tab

In the Copy Options tag the following configuration options are available in the General
area.

Creates the copy using the on-the-fly method.

If this check box is cleared, the copy is created using the copy-
over-image method.

Check box
On-the-fly

The following configuration options are available in the Copy Options tab in the source
area:

Selects the drive for reading the disc.

If a copy over image is created, we recommend that you select
the recorder for reading in.

Drop-down menu
Drive

Drop-down menu

Defines the speed at which the disc is read in.
Read speed
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11.3.3Read Options

The Read Option tab consists of several areas. In these areas it is possible to set options
for reading an original disc.

Mew Compilation X
4 DND = | | Image | Copy Options | Read Optons || Burn
& Profile
: I'] Profie selection:
o  DVD-video -

DVD-ROM (UDF)

Error correction

e @ R=ading with error correction (slow and safe)
Read retry eount:
East reading without error correction {fast and unsafie)

Handling of non-correctable read errors

J L
DYD-Video Ignore read errors

AVCHD{TM] video

:—*‘ béero Express ] --: i_[;m:mfu J |~'In- Copy | {o Cancel

Read Options tab

The following configuration options are available in the Profile area:

Selects predefined copy settings or a user-defined setting.

Drop-down menu In the case of predefined copy settings, Nero Burning ROM sets

Profile selection the configuration options automatically. You can select the
configuration options yourself with a user-defined setting.

The following configuration options are available in the Data tracks area for the CD disc
type:
Ignores read errors on the original disc and continues the read

Check box process.
Ignore read errors  If this check box is cleared, Nero Burning ROM may interrupt the
burn process depending on the type of error.
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Passes on corrupt sectors anyway (that have caused read errors)

Check box for burning.
Write defect sectors  If this check box is cleared, corrupt sectors are not passed on and
remain blank.
Check box
Read sectors in raw Reads PQ subchannel data.
mode
Check box Reads all subchannel data during copying. Subchannel data is
Read all subchannel used to save additional information.
data The burner has to be capable of reading all the subchannel data.

The following configuration options are available in the Audio tracks area for the CD disc
type:

Ignores read errors on the original disc and continues the read
Check box process.

Ignore read errors  If this check box is cleared, Nero Burning ROM may interrupt the
burn process depending on the type of error.

Reads the audio file indexes. This is particularly useful for copying

Check box _ _ : " .
dind ¢ an Audio CD as it makes sure that all index positions of the Audio
Rea clin zxes 0 CD are copied correctly. The disadvantage is that it increases the
audio data time it takes to analyze a disc before the copy process starts.
Check box Reads all subchannel data during copying. Subchannel data is
Read all subchannel used to save additional information, e.g. CD Text.
data The burner has to be capable of reading all the subchannel data.

The following configuration options are available in the Advanced area for the CD disc type:

Check box Reads the media catalog number, a globally unique number for
Read Media Catalog compilations, and the ISRC (International Standard Recording
Number and ISRC  Code), a globally unique number for audio recordings.

Check box . | | |
y , Jitter corrector removes scratches from audio and video files.
Use jitter correction

The following configuration options are available in the Error correction area for DVD and

Blu-ray Disc:
Option button Performs error correction while reading. In the process, the
Read with error checksum of a corrupt sector is adjusted so that the sector in itself
correction is consistent.
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Input field Establishes the number of attempts that are made to correct
Read retry count  errors.

Option button
Fast reading without Performs fast reading without error correction.
error correction

The following configuration options are available in the Handling of non-correctable read
errors area for DVD and Blu-ray Disc:

Ignores read errors on the original disc.

If this check box is cleared, Nero Burning ROM may interrupt the
burn process depending on the type of error.

Check box
Ignore read errors

~ With Audio CD, read errors often have little or no impact because they are not
’ ? perceptible when the CD is played.
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12 Erase Rewritable Disc Window

Nero Burning ROM can be used to erase rewritable discs, i.e. discs with the RW
specification, as long as your recorder supports this feature. Two erase methods are
available for this purpose:

Quick erasing does not remove the data physically from the disc, but instead only makes it
inaccessible by erasing the references to existing content. The data can be restored!

Full erasing removes the data from the disc by overwriting it with zeros. The contents cannot
be restored with conventional methods. Repeated full erasing increases the probability that
third parties will not be able to reconstruct the contents.

& Erase Rewritable Disc 8|Sl

Select recorder:

Z, D:HL-DT-ST DVD-RAM GSA-H22L -

[ Use multiple recorders

Select the erase method to be used:
|Guickemse rewritable disc j

The disc will appearto be empty but data is not physically erased.
|Use this option with caution f the disc contains corfidential data.

Erase speed:

Mazdrmum j

Eraze Cancel |

Erase Rewritable Disc window

The following configuration options are available in the Erase Rewritable Disc window:

Selection list . .
Defines the desired recorder.
Select recorder

Check box

) Simultaneously erases CDs/DVDs in multiple recorders.
Use multiple recorders

Defines the erase method. Two options are available:

The Quick-erase rewritable disc method does not physically

Select the erase erase all data from the disc, but only the references to the
method to be used  contents. The disc will appear to be empty even though the data
is still physically available. Erasing a disc using this method

Selection list
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Selection list
Erase speed

Button
Erase

Button
Cancel

takes between one and two minutes.

The Full-erase rewritable disc method physically erases all
data from the disc. The contents cannot be restored with
conventional methods. Repeated full erasing increases the
probability that third parties will not be able to reconstruct the
contents. Erasing the disc using this method takes longer than
the other method, depending on the type of disc involved.

Defines the erase speed.

Starts the erase process.

Cancels the action and closes the window.
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13 About Nero SecurDisc Viewer

Nero SecurDisc Viewer is a standalone application that is part of the SecurDisc technology
platform. SecurDisc is a technology developed by Nero and HLDS to create discs with
special protection properties. No special hardware is needed.

Nero SecurDisc Viewer is available as a free download at www.securdisc.net or
www.nero.com and is also included automatically in a SecurDisc disc that is burned with
Nero Burning ROM or Nero Express.

Discs that are created with Nero and the SecurDisc compilation type include data integrity
and reconstruction. Additionally the data on the SecurDisc disc can be protected against
unauthorized access by using a password. The data can also be digitally signed. Nero
SecurDisc Viewer allows you to copy the protected data to your hard drive and to check the
security of the data.

’ = More information on SecurDisc technology can be found at www.securdisc.net.
F

See also
g Compiling a SecurDisc disc —29

13.1 Starting Nero SecurDisc Viewer

Nero SecurDisc Viewer is included automatically in a SecurDisc disc that is burned with Nero
Burning ROM or Nero Express. Insert the SecurDisc disc in a drive to open Nero SecurDisc
Viewer automatically.

Nero SecurDisc Viewer can also be opened by double-clicking the
NeroSecurDiscViewer.exe file. This file can either be found on the SecurDisc disc or it can
be downloaded from www.securdisc.net or www.nero.com.
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I = ¥
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Main screen

13.2 Copying Data to Hard Drive

With Nero SecurDisc Viewer you can copy the files from the SecurDisc disc to your hard
drive. If the files have been protected against unauthorized access, you can insert the
password here.

Proceed as follows:
1. Select the check boxes of the files you want to copy to the hard drive.

2. Click the Save to button.

= |f data on the SecurDisc disc is password-protected, the Password Protection window
is opened.

-

"Q Password for Mero (:) @

%

.

‘0 Apply | r Cancel ‘

3. Enter the password in the text box and click the Apply button.
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= An explorer window is opened.

4. Select the required folder and click the OK button.

= The Copy Data window is opened and the files are copied. You can follow the progress
with the status bar and the displayed messages. As soon as the copy process is
finished, a message is displayed to notify you.

= The selected files are copied to the selected folder.

13.3 Checking Data Integrity

Nero SecurDisc Viewer can be used to check the data integrity of a SecurDisc disc by using
the checksum feature. The data integrity check warns you if the data on a disc is at risk of
disc decay so that you have time to back it up to another disc.

Proceed as follows:

1. Click the Integrity button.

= The File Integrity Check window is opened and the integrity check is carried out. You
can follow the progess with the status bar and the displayed messages.

= As soon as the integrity check is finished, a message is displayed to notify you about
the result of the check.

Data Integrity Checking for Drive: D EI@
Time Event Result
ﬂ 01.06,2010 11:20:21 Finished Successful
Current file:
Total progress:
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13.4 Checking Signature

With Nero SecurDisc Viewer you can verify the authenticity of the SecurDisc disc if it is
digitally signed. You need the public key from the distributer of the SecurDisc disc for this
purpose. By checking the public key, Nero SecurDisc Viewer is able to confirm that the data
is authentic and has not been manipulated.

Proceed as follows:

1. Click the Signature button.
= An explorer window is opened.

2. Select the public key (*.bpk) which the SecurDisc disc is signed with.

Public key

The creator of the SecurDisc disc has also created or selected the public key for
the disc. The key is to be distributed by the creator of the disc, too.

3. Click the OK button.
= The explorer window is closed and the Check window is opened.

= The signature is checked. You can follow the progess with the status bar and the
displayed messages.

= As soon as the copy process is finished, a message is displayed to notify you about
the result of the check.

Digital Signature Verification of Drive: D EI@
Time Event Result
ﬂ 01.06,2010 11:20:43 Digital signature verification for drive: (D) started Done
ﬂ 01.06,2010 11:20:57 Finished Successful
Current file:
Total progress:
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14 Nero MediaBrowser
Nero MediaBrowser is a tool which you can use to easily find, view and access media files
and add them to your project.

More precisely, with Nero MediaBrowser you can access a media library which contains all
your media files that were indexed by Nero Kwik Media. Nero MediaBrowser is designed to
be accessed in several Nero applications.

: Nero MediaBrowser and the media library come with Nero Kwik Media and are
‘@ installed together. You will find further information in the Nero Kwik Media
manual.

Nero MediaBrowser can be opened via the ﬁ icon. Although Nero MediaBrowser can be
moved freely around your desktop, it is part of Nero Burning ROM.

Nero MediaBrowser displays only media files which can actually be used in the relevant
Nero Burning ROM project. To add media files to your project, select the media files in Nero
MediaBrowser and click the Add button.

Photo Video Music 1
Time

Recent

Folder

Faces

Favaorites (0]

B tew stbum 01

Ll _—1
Jun - Aug 2011

BN A o
s g -

Nero MediaBrowser
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The browsing task bar is the starting point for browsing Nero MediaBrowser. The categories
(Photos & Videos, and Music) are the same as featured in Nero Kwik Media. Each of the
categories offers a search bar. It is only possible to search within one category at the same
time. When one of the categories is clicked, the corresponding browsing area is displayed
below.

There are different views available for each category: Clicking one of the entries in the upper
part of the list (for example Timeline) displays the same view as when clicking the
corresponding tabs in Nero Kwik Media. Clicking one of the collections in the lower part of
the list displays the collection contents made within Nero Kwik Media. When one of the list
items is clicked in Nero MediaBrowser, the corresponding content is displayed in the content
area below.

A dynamic scroll bar is used in the content area. If the scroll thumb is dragged in a
direction, the content will be constantly scrolled in this direction. The scrolling speed
increases the further the scroll thumb is dragged from the center. If the scroll thumb is
released it jumps back to the center position and stops the scrolling.

The following views are available for the Photos & Videos category:

Displays all photos and videos sorted in chronological order by

Entr .
try creation date.

Timeline Refers to Timeline in the upper task bar of Nero Kwik Media.

Displays all photos in which faces of persons have been detected
and named listed in alphabetical order. Unconfirmed or unnamed
faces are not displayed. Faces are grouped into stacks; you can
access one of the stacks by double clicking it.

Refers to Faces in the upper task bar of Nero Kwik Media.

Entry
Faces

Entry Displays all existing tags enabling you to create a query.
Tags Refers to Find in the upper task bar of Nero Kwik Media.

Collections Displays the currently marked or rated content.
Marked / Rated  Refers to Marked / Rated in the sidebar of Nero Kwik Media.

Collections Displays the recently added or modified content.

Recently added / | Refers to Recently added / Recently modified in the sidebar of
Recently modified Nero Kwik Media.

Collection Displays the content of smart albums and user generated albums.
Refers to Photo & Video Albums in the sidebar of Nero Kwik
E Album .
Media.
: Displays the content of user generated person groups. You can
Collection
switch between full photo and faces only view with the S& / ﬁﬂ
%Person group .
icon.
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Refers to Faces in the sidebar of Nero Kwik Media.

The following views are available for the Music category:

Entry
Albums

Entry
Artists

Entry
Genres

Entry
Songs

Collections
Marked / Rated

Collections

Recently added /
Recently played

Collection

) Playlist

Displays all audio tracks sorted in alphabetical order by album.
Refers to Albums in the upper task bar of Nero Kwik Media

Displays all audio tracks sorted in alphabetical order by artist.
Refers to Artists in the upper task bar of Nero Kwik Media

Displays all audio tracks sorted in alphabetical order by genre.
Refers to Genres in the upper task bar of Nero Kwik Media

Displays all audio tracks sorted in alphabetical order by title.
Refers to Titles in the upper task bar of Nero Kwik Media

Displays the currently marked or rated content.
Refers to Marked / Rated in the sidebar of Nero Kwik Media.

Displays the recently added or played content.

Refers to Recently added / Recently modified in the sidebar of
Nero Kwik Media.

Displays the content of user generated playlists.
Refers to Playlist in the sidebar of Nero Kwik Media.

The Options window is opened when you click the « button on the upper task bar. The

options refer directly to Nero Kwik Media. The following setting option is displayed:

Library

Displays the Library Manager settings area.

All monitored folders are displayed in the respective Watched folders
or drives area. If you want to add additional media folders, click the
Add button and select the desired folder from the navigation tree.
The library is refreshed when launching Nero Kwik Media. To delete

a folder from the application's watchlist, click the » button.
You can also just drag files or folders to Nero Kwik Media . A window

automatically opens and asks if you want to add the folder(s) to the
library.

Nero Burning ROM
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15 Configuration Options

You can define options for working with Nero Burning ROM in the Options window.

[ Options @

Database | Ulrabuffer | FleBrowser | Misc | Lightscribe
Compilation | Cache I Font | Sounds | Expert Features

-

..............................................

[¥] Remember name of last used disc
| Show compilation size in the Mero status bar

[T Clear archive bits of written files during IS0 refresh

[ Allow semicolons in Joliet names

¥| show original path with 150 compilation

ok [ gl ][ o

Options Window
The following tabs are available:
Compilation Contains options for the compilation and the selection screen.
Cache Contains options for the cache.
Font Contains selection options for the font.
Sounds Contains selection options for sounds in connection with burn tasks.
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Contains options for configuring overburning and burning.

Expert Features ] .
We recommend that you retain the default settings.

Selects the default naming method for audio files to be saved from

Database an Audio CD to the hard drive.
Ultrabuffer Defines the size of the RAM buffer.
File Browser Contains options for configuring the file browser.
Misc Contains options for configuring compilations, burning, the database,
' the user interface, as well as advanced settings.
Contains options for configuring LightScribe recorders such as the
LightScribe print contrast (quality), default drive, and default template.

This tab is only available if a LightScribe recorder has been installed.

15.1 Compilation Settings
The following configuration options are available on the Compilation tab:

Check box Opens the New Compilation window automatically
Start with new compilation ~ when starting Nero Burning ROM.

Uses the Disc name of the last compilation for a new

Check box i
b  last q compilation.
Remember ngirz((:a otlastuse If the check box is cleared, the Disc name is set to New
for a new compilation.
Check box

Show compilation size in the Displays the storage volume of your files in a status bar.
Nero status bar

Clears the archive bit of the source file (e.g. from the

Check box hard disk) as soon as the burn process has finished.
Clearing of the archive bit is of informational value and

Clear archive bits of written indicates that this file has been archived.

files during ISO refresh
If this check box is deactivated, the archive bit of the file

remains unchanged.

Check box Allows the use of semicolons in addition to standard
Allow semicolons in Joliet  uppercase and lowercase letters and Unicode

names characters in file names in the Joliet file system.
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Check box

Show original path with ISO
compilation

15.2 Cache Settings

Configuration Options

Lists the full path of the added files in the compilation
screen in the Source column.

The following configuration options are available on the Cache tab:

Input field
Path for cache

Button
Browse

Input field

Minimum space on hard drive,
which Nero should not use

Check box

Immediately cache files that
have been copied from an
optical drive

15.3 Expert Features

Displays the path of the Cache memory.

You can enter the path manually or select the path in
the browser window.

Opens a browser window.

You can select a folder in which data is buffered before
and during the burn process.

Defines the minimum storage volume on the cache drive
that is not used by Nero Burning ROM.

Saves files that have been added to the compilation
from a source disc in a temporary directory.

If you clear this check box then you have to insert the
original source disc during the burn process.

The following configuration options are available on the Expert Features tab:

Check box

Enable Disc-at-once CD
overburning

Drop-down menu / Input field

Absolute/Relative maximum
overburning size

Check box
Enable DVD overburning

Nero Burning ROM

Enables the option that CDs can be overburned.

Defines how much a CD can be overburned.

Enables the option that DVDs can be overburned.
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Drop-down menu / Input field
Maximum DVD size

Defines how much a DVD can be overburned.

Check box
Enable generation of short Enables the option to write additional data to your CD.
lead-out
Check box Enables the option that your disc remains in the
Do not eject the disc after the recorder and is not ejected when the burn process is
burn is complete finished.

Enables the option that all supported recorder formats
for the Image Recorder are available.

Check box

It is now possible to create compilations that the
installed recorder cannot burn. For instance, you can
create a Blu-ray compilation without a Blu-ray recorder
and create an image file with Nero Image Recorder.

Enable all Nero supported disc
types for the Image Recorder

Check box Renames the file extensions to fit the AVCHD
Enable automatic renaming of specifications. AVCHD content on optical discs requires
AVCHD file extensions four letter extension to be detected as an AVCHD disc.

Allows Nero Burning ROM to be started from the shell

Area context menu. The shell context menu offers various
Nero burn functions in the pertinent information and is opened by clicking a file or
context menu folder with the right mouse button in the Windows
Explorer.

Area / Button

Resets all settings back to the original factory settings.
Restore

Overburning

Overburning means writing more data on the disc than originally intended. It is
achieved by reducing the lead-out area to a few seconds, which is sufficient in
most cases. However, this violates the CD standard and may result in recording
and playback errors (depends on the used recorder).

<

15.4 Ultrabuffer Settings

The following configuration options are available on the Ultrabuffer tab:

Selection list Defines the memory capacity that Nero Burning ROM
Method uses as a RAM buffer.
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The ultrabuffer is a second memory that enhances the

physical buffer in the recorder.

Defines the memory capacity that can be manually
Input field entered.

Data buffer size The input field is only enabled when Manual
Configuration is selected in the selection list.

15.5 LightScribe Settings

The following configuration options are available on the LightScribe tab:

Area . . . .

) Adjusts the desired print quality.
Print contrast

Selection list

, i , Selects the drive with the LightScribe recorder.
Default LightScribe drive

Selection list n
Specifies the genre.
Genre
Selection list

Defines a template for labels.
Current template

Selection list

, i Adjusts the desired print resolution.
Default print resolution (DPI)

Offers the option to create and burn a LightScribe label
Check box automatically when burning with a LightScrive recorder.

Always print LightScribe label This tab is only available if a LightScribe recorder has
been installed.
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AlIFF

The Audio Interchange File Format is an uncompressed audio file format from Apple® and
represents a sort of counterpart to the WAV format from Microsoft. Files are larger than
when using a compressed format, but the quality is higher. AIFF compressed is the
compressed variation.

Archive Bit
Archive bits are used to identify files that have been edited. A file is only resaved during the
next backup process if it was edited (and an archive bit is thus reset).

AVCHD

AVCHD is an HD capturing format for camcorders. It is used for DVDs but compatible to Blu-
ray Discs.

Book Type

The book type defines the specification (e.g. DVD-, DVD+, DVD-ROM) of a DVD. In order to
ensure correct playback, the DVD specifications are defined in books so that all media can
be read correctly. The specifications are defined in the so-called Rainbow Books, which are
distinguished by means of their color (e.g. Yellow Book).

Bootable CD

Booting refers to loading the operating system when a computer is started. This is normally
done from the hard drive. However, if you do not want to boot or cannot boot your computer
from your hard drive for whatever reason, you can load an operating environment from the
drive with a boot CD.

Buffer
A buffer refers to temporary memory that records and delivers data that cannot be processed
immediately as required. The buffer also allows for continuous data flow.

Buffer Underrun

A buffer underrun is an interruption in the data flow in the internal memory (e.g. of the
recorder). A buffer underrun results from an interruption in the data flow to the internal buffer.
The buffer continues to deliver data until it is finally empty. When recording, data is fed
continuously to the recorder's buffer in order to keep a steady flow of data. If the steady flow
of data is interrupted, the media becomes unusable. Most modern recorders have a
protective mechanism against buffer underruns.

Cache
Cache is a faster buffer that is used in various areas of a computer to access larger data
volumes faster. Cache ensures a continuous flow of data.
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CD-R
Compact Disc-Recordable is a technology for write-once media. The Orange Book standard
defines the storage of audio data and other computer-readable data.

Codec

The compressor/decompressor encodes the data for recording or saving digitally and then
decodes it for playback. Various software codecs are available such as Cinepak, Indeo,
Quicktime, Video for Windows, etc. Hardware codecs include MPEG, H.261, Motion JPEG,
etc.

Disc-At-Once

Disc-At-Once refers to a method in which the laser in your disc burner burns the disc in one
pass without turning off and on between each track. This method is best when recording
Audio CDs you would like to play in your home or car stereo.

Frame

With an Audio CD, 75 sectors provide one second of played music. One sector consists of
up to 98 frames; one frame contains 24 data bytes and 9 control bytes. Similarly, "frame"
describes a full screen in television and video technology. Two successive half images result
in a full screen within a second due to interlacing.

Image

An image refers to a single file on the hard drive that contains the image of a complete disc.
A disc image can be used to create exact copies on media at a later point in time if problems
occur during the write process or if no recorder is connected to your PC. The image requires
as much free space on the hard drive as the contents of the original disc take up.

Jitter

Jitter refers to an abrupt and undesired change in the signal characteristics. Small gaps
occur in the data stream as a result. Audio correction synchronizes the data by overlapping
the sectors. This way, the gaps are not audible.

Joliet

Joliet refers to an extension of the 1ISO-9660 standard for file names. Joliet was designed by
Microsoft in order to represent more characters. The file name can be up to 64 characters
long and contain the letters A-Z, a-z, umlauts, as well as characters from Chinese,
Japanese, and Korean.

Label
A label refers to a label on a disc. Some drives, e.g. drives that use LightScribe or Labelflash
technology, can transfer labels directly to special media.

Labelflash
Labelflash is a technology with which pictures and texts can be burned on the label or data
side of a disc with a laser.
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LightScribe
LightScribe is a technology with which pictures or texts can be burned on the label side of
discs with a laser.

MP3

The MPEG-1 Audio Layer 3 audio format is used to reduce the size of audio files to a
fraction of their original size (factor 1:10) with little loss of quality. You can estimate about 1
MB per minute as opposed to 10 MB for the original files. This value and the quality can vary
depending on the complexity of the audio signal. The bit rate used can be used as a
measure of quality. The higher the bit rate, the better the quality, but also the more memory
required.

mp3PRO

mp3PRO is an MP3 codec that compresses audio files even more but in lower bit rates and
better quality. 64 kBit/s in mp3PRO is the equivalent to 128 kBit/s in MP3.

MPEG-1

The Moving Picture Experts Group defined this industry standard for video and audio
codecs. MPEG-1 is part of the MPEG compression family and has the highest compression
rate. MPEG-1 is the format for video CDs.

MPEG-2

The Moving Picture Experts Group defined this industry standard for video and audio
codecs. There is little difference between MPEG-1 and MPEG-2: MPEG-2 is a broadcast
standard and better for televisions that are interlaced. MPEG-2 is used as a video format for
DVDs.

Multisession

A multisession refers to completing a disc in multiple cycles. After a first session has been
written to the disc, information can then be added in another record because the disc has not
been finalized.

Nero AAC

Various MPEG-4 video and audio codecs are collated in Nero AAC and are fully compatible
with the standard MPEG-4. Nero AG is continuing to develop these. In this way a
substantially higher quality of the multi-media data is achieved. Further, additional features
such as subtitles have been implemented.

Sector

A sector is the smallest addressable information unit on a disc. A sector is composed of
2,352 bytes, of which - depending on the type of disc used - different amounts are available
as user data. A sector generally consists of a header, synchronization bits and user data. It
may also have error recognition and correction data.
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Track-At-Once

Track-At-Once refers to a write method in which each track is written to the disc individually.
The writing process is interrupted briefly after each track, i.e. the laser starts again for each
track. With this write method, it is only possible to continue writing to a DVD sometimes and
at a later stage. There is a pause of at least 27ms between tracks, which can be disruptive
for Audio CDs.

WAV

The WAV audio format, also called WAVE or Waveform audio format, is an audio format
from Microsoft and uses no data compression. WAV is the counterpart to the AIF format from
Apple.
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